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Introduction -
-

1 Introduction

ENM System Monitor (ESM) monitors the performance of servers and
applications, raises alarms on breach of predefined thresholds. It provides a
web interface to control and display the data it handles.

Purpose

This document describes how to use ESM User Interface.

Target groups
The intended target groups for this document are as follows:

— Non-Administrative Users

Requirements

The user is assumed to have the following:

— Knowledge of how to access the ENM homepage.

— Appropriate ID, account, and permissions.

The user is using one of the following web browsers:

— Chrome stable latest (ENM is verified on Chrome 47).

— Firefox ESR latest (ENM is verified on Firefox 38.4.0, 42).
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ESM Overview

ENM System Monitor (ESM) consists of a single-instance server and
multiple agents. The agents are installed on various platforms including
Management Server (MS) to be monitored.

The agents transmit information to the server where it is displayed on a portal,
which the user views using a supported web browser. The information displayed
is used to determine if the ENM servers being monitored are operating correctly.
The key components of ESM are:

— RHQ Server

— RHQ Agent(s)

— Asupported database

— JMX enabled resources to monitor.

This section contains the routine operation and maintenance tasks related to the
System Monitoring application.

ENM System Monitor performs the following functions:

— Monitoring of hardware metrics for all server platforms

— Monitoring of operating system metrics for all server platforms

— Monitoring of metrics that are exposed by ENM applications

— Alerting of any breach of a configured threshold on a metric

— Forwarding of alerts as a stateful alarm to ENM fault management
— Near-realtime and historical viewing of metrics

ENM System Monitor provides a web-based application for performing
management actions.

A customizable portal offers critical information quickly to the right audiences.
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Access ESM

Access ESM

This task describes how to access ESM.

Steps

1.

N

AR

Log on to ENM launcher page as an administrator or as a user with
System_Monitor role.

Click the ENM System Monitor link.
Enter the username and password supplied by local Ericsson support.

Click Log in.

\\

It is recommended to change the default password after the first login. See

section Change Default Password for ESM Users on page 4 for more
details.

Note: If the web portal is inactive for longer than the maximum idle time

period, the session is closed automatically.

To log out, select Logout from the top-right corner of any page.

X esmadmin +

Logout

- ||
hljlh TE I Tl Sl [ ! T BN ™ Fi® o T P Tl e R
]

Results

ESM Dashboard is launched.

1/1553-CNA 403 3115 Uen AM | 2020-11-02




\\

3.1

ENM System Monitor User Guide

—— RELATED INFORMATION —
3.1 Change Default Password for ESM Users on page 4

Reference List on page 79

Change Default Password for ESM Users

ESM user is provided with the default password by local Ericsson support.
The default password of ESM user is to be changed when the user logs in for
the first time.

Prerequisites

User is logged on to ENM launcher page as administrator or as user with
System_Monitor role.

Stop!

Do not change the default password of rhqadmin username, which is internally used to
configure the RHQ server and do scheduled tasks. Changing the default password of the
username rhqadmin results in failure of the rpm installations and causes the upgrade or
rollback to fail.

Steps

1. Logonto ENM launcher page as administrator or as user with
System_Monitor role.

2. Click ENM System Monitor link.

3. Logonto the ESM using the username and password that are provided in
section User Management for ENM System Monitorof ENM Identity and
Access Management System Administrator Guide.

4. Click Login.

5. Navigate to the user at the top right section and click it.
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%~ | W0 & esmadmin

Settings

Dashboard Inventory Reports ~ Bundles Administration v Help

Logout

=|/2) Inventory Summary 2/ #[2][%] |-|/3| Recent Alerts 2% [2][x
Platform Total 5 Matching Rows: O (selected: 0)
T Total - Creation Time *| Name Condition 1 Condition Value  Priority Acknowledge Recovered | Resource &

ce Total No results found using specified criteria.

%~ | M0 | L esmadmin ¥

Dashboard Inventory Reports + Bundles Administration ~

v Security Y US@I’S

& Edit User [esmadmin]

v Topology
B servers Username : esmadmin LDAP Login? : no =
& storage Nodes Password *: ererees Verify Password *: eeees
@ Agents FIrst Name *: jesmadmin Last Name * : lesmadmin
*8 Affinity Groups Emall Address *: esmadmin@asm.com Phone Number :
) Partiicn Events Department Login Enabled? *: (@) yes no

v Configuration
Customize User Interface

"

b

p Drift Definition Templates Roles
# Metric Collection Templates

£} Ignored Resource Types

Available Roles Assigned Roles
£} Missing Resource Policy
[3] Downloads Name Name
% Agent Plugins M All Resources Role . Super User Role
% Server Plugins @ ESM_ReadOnly
% e M ESM_AlertManage!
42
Content Sources
[ “ -

A Repositaries
Save Cancel

7. Enter the new password in the Password and Verify Password fields.
8. Click Save.

9. Change default passwords after first logon.

Results

Default password of ESM is changed.
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4 Navigate ESM User Interface

ESM user interface provides access to view all resources and event
information. The ESM interface is available to all ESM defined users.

Note: — ESM uses the 3PP tool. Check out the following site for help
information on using it: Attps://docs.jboss.org/author/display/RHQ/
Release+Notes+4.13.

— ESM GUI fails to open if the system date or time is incorrect, which is
a known 3PP limitation.

—— RELATED INFORMATION —
4.1 Configure the Dashboard on page 6
4.2 Customize Views on page 7

4.3 Alerted or Unavailable Resources on page 8

4.1 Configure the Dashboard

Dashboard contains multiple views, each of which presents a summary view
of events and resources.

Dashboard contains the following views:

— Recent Alerts

— Alerted or Unavailable Resources

— Recent Operations

— Inventory Summary

Note: — Some alerts may be duplicated in Recent Alert view.

— Recent Alerts view cannot be sorted..

Each of the views presents a summary view of events and resources.

Dashboard can be tailored based on individual user and customized by
reorganizing the views and filtering the data shown.
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L 4 [ X esmadmin ¥

Dashboard Inventory Reports v Bundles Administration v Help (i) Saved dashboard ESM Default to server X
ESM Default Edit Mode || New Dashboard
== X

Inventory Summary _I/a Recent Alerts ™

Platform Total :
seform Towl Matching Rows: 3 (selected: 0)

Creation Time »| Name Condition 1 Condition Value | Priority Acknowledge Recovered | Resource

Metric

Value

Range

Linux - Idle licle]

W23NT739PM between 226 % ol cloud-ms-1
’ [16.0%]
and [100.0
Average Metrics per Minute : 38 %],

m

m

=3/ Platform Utilization *| |=//=] Alerted or Unavailable Resources x

Total: 20

Total Rows: 5 (selected: 0)
Resource Ancestry Alerts Avallabllity,
Nam Avallability Vers| CPU| Mem Swap

2 @

Linux =
clou ; } 1 =
G 26377.4%1.09%.0%) @

} 5045 0 @

Linux . . 0 @

esmc @ 26357.89§4.5%0.00% 990} RHQ S cesmon O 1)

Steps

1. Click New Dashboard at the top-right of the ESM web console to create a
new Dashboard tab.

2. Click X located in the Dashboard tab to delete a dashboard.

3. To automatically refresh your dashboard to periodically pick up new data,
use the Refresh Interval drop-down menu.

4. Disable automatic refresh by turning off this feature.

4.2 Customize Views

Each dashboard can have any number of views.

The limitation to the number of views you can have is limited to your monitor's
screen size.

Steps
1. Use the Add Portlet drop down menu to pick the view you want to add.

2. Some views support further customization through their configure icon
found in the top-right corner of the view's title bar.
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3. You can move the views around the dashboard by clicking and dragging the
view's title bar.

4. Toremove a view from a dashboard, click X located in the top-right corner of
the view's title bar.

Alerted or Unavailable Resources

This portlet shows the unavailable resources or the alerts for the resources
that have been raised on.

Unavailable resources include file systems, CPU, and any services on a platform.
If any of the resources are configured to be highly available, which means if it is
deployed on a different service groups (VMs) either in active-active or active-
passive mode, this section shows only the resources which went down.

ESM cannot detect if a resource is going down in one platform, the same resource
is available on another platform. ESM treats each resource independently.

-I[5] Alerted or Unavailable Resources

>

[ N VRV NSV O VN S S

99000QRARARARRARRARRS
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5 Inventory

The Inventory page provides access to all resources monitored by the
application.

The page can be accessed by selecting the Inventory tab on the top navigational
bar.

%~ | ™1 2 esmadmin ¥
Dashboard Inventory ~ Reports Bundles Administration ~ Help

T Z |nventory

@), Discovery Queue
& All Resources

5 Platforms From this section, newly discovered Resources, inventoried Resources, and Groups can be viewed and managed
E3 Servers - Top Level Imports
B3 Servers
£} Services
@& Ignored Resources
B3 Unavailable Servers
v Groups
=3 All Groups
# Dynagroup Definitions v
22 Compatible Groups
*4 Mixed Groups

B8 Problem Groups

The main section of the Inventory page is the Resources list. All monitored
systems can be found under its various subsections.

Discovery Queue

Only system administrators have access to the Discovery Queue.

All Resources

All Resources page displays all resources monitored by the system across all
platforms.

Non-administrator users can use this list to search for and view metric data of
any resource by selecting its name from the list.

Platforms

Platforms page lists all monitored systems at the operating system level.

Every platform on the list can be selected to view its specific metrics.
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kv | M1 | 2 esmadmin ¥

Dashboard Inventory Reports ~ Bundles Administration  ~ Help
_

£ Bundle Handler - Ant ’ EClOUd'db_1 (Linux) i
83 Bundle Handler - File Template Tags: @

plLeEE Summary Inventory Alerts Monitoring Events Operations Drift Content

» &8 File Systems

> 88 JBossAST Standalone Servers Acuvity Timeline

b k Adapters -

~|/=/ (@] Resource: Measurement |#|/%/[7][x| [=|/o| ® Resource: Alerts 2| (=] [7][]| =

<3> Wildfly/|Boss EAP Patch Handler

Matching Rows: O (selected: 0)

= || Creation Time = N C¢ Con Priority AC Recovered .

]

No results found using specified criteria

Note: Availability is not updated automatically, a browser refresh is required to
get the updated status.

Servers - Top Level Imports

Servers page lists all monitored resources with server functionality, but it does
not include resources under them.

Every server on the list can be selected to view its specific metrics.

Servers

This page lists all monitored resources with server functionality, including their
child servers.

Every resource on the list can be selected to view its specific metrics.

Service

Service page lists all resources detected on Servers (for example, a JMS Queue on
a JBoss AS server).

Ignored Resources

Ignored Resources page lists all resources that are explicitly ignored by the
system.

Unavailable Servers

Unavailable Servers page lists all resources that were detected but can not be
contacted to collect new metrics.
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Groups

Groups are not supported in ESM.
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6 Access ESM Operating System Metrics

ESM collects the operating system metrics. These metrics are visible to all
the users of ESM and no specific permissions are required to view them.

The metrics are collected on a per-minute basis.

Prerequisites

The user is logged on to ESM.

Steps

1. Click Inventory.

Dashboard Inventory Reports v Bundles Administration Help

v Resources

Inventory

@), Discovery Queue

& All Resources

& Platforms

B3 Servers - Top Level Imparts
B3 Servers

£ Services

& Ignored Resources

From this section, newly discovered Resources, inventoried Resources, and Grov

B3 Unavailable Servers
~ Groups
=2 All Groups
# Dynagroup Definitions N
i1 Compatible Groups
=2 Mixed Groups

B8 Problem Groups

2. Click Platforms.

3. Select any platform from the list.

12 1/1553-CNA 403 3115 Uen AM | 2020-11-02
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*v | ™1 | 2 esmadmin

Dashboard Inventory v Reports ~ Bundles Administration ~ Help

v Resources E P\athFmS
@), Discov

@& All Resources

B3 Servers - Top Level Imports Name = Ancestry Description Type Version | Avallability
B3 Servers
Linux Operating Linux
% Services B cloud-db-1 System Linux 26.32- @
& |gnored Resources ) Sbasale
- (T oy Linux
3 Unavailable Servers é;ﬁ;‘f\"‘e”“‘ € Linux 2632 @
v Groups o 504541¢
Linux
=2 All Grt s Li Operat
Allroup B cloud-svc-1 INUX OPEFEtng oy 26.32- @

# Dynagroup Definitions » i B sve-1 [Platforms,

22 Compatible Groups

*% Mixed Groups
88 Problem Groups
= esmon Linux Operating Linux @

System

4. Click Monitoring > Metrics to view all metrics collected for the specified
platform.

*~ | ™1 | 2 esmadmin ¥

Dashboard Inventory ~ Reports ~ Bundles Administration ~ Help
SN - kg
483 Bundle Handler - Ant 4 EClOUd SYC- T uinux) CA%
& Bundle Handler - File Template Tags: B
> 88 CPUs

Summary Inventory Alerts Monitoring Events Operations Drift Content
> B File Systems
> 88 Network Adapters Traits  Schedules
> E3RHQ Agemt

{83 Wildfly/|Boss EAP Patch Handler 1h | 4h | 8h | 12R 1d | 5d | im| 3m| 6m| Custom..| 01/23/2017 7:26 am - 01/23/2017 3:26 pm (8 hours)

Avallapllity
up

DOWN | | | |
> 08 AM 00 AM 10 AM 1AM 12PM 01PM 02PM 03 PM

I Total Rows: 9 (selected: 0)

Chart Name Minimum Maximum Average Live Value Alerts

» Actual Free Memory 45.3319Ge 112371 GB 49.9 GB 454 GE 0 =

» Actual Used Memory 18313 GB 68.8705 GB 64.3024 GB 688 GB o

» Free Memory 32.5963 GB 111.9484GB = 37.6032GB 327GB 0 =

» Free Swap Space 5GB 5GB 5GB 5GB o

» Idle 348% 817% 583% 579% o

» System Load 33% 12.3% 13.50% 11.6% o .
Add to Dashboard - | ESM Default - Add Refresh

Results

The user is able to access Operating System Metrics that are collected by ESM.

—— RELATED INFORMATION —

6.1 ESM Operating System Metrics on page 14
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The following table contains the list of Operating System Metrics that are

collected by ESM.

Table1l ESM Operating System Metrics

S.No

Metric Name

Description

1

Actual Free Memory

The actual total free system
memory (includes unallocated
memory as well as available
buffer and measurement cache
memory)

Actual Used Memory

The actual total used system
memory (includes buffer and
cache memory)

Free Memory

The total free system memory
(does not include buffer or cache
memory)

Free Swap Space

The total free system swap

System Load

Percentage of all CPU's running in
system mode.

Used Memory

The total used system memory
(does not include buffer or cache
memory)

Used Swap Space

The total used system swap

Used Load

Percentage of all CPU's running in
User mode.

14
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/ View ESM Hardware Metrics

ESM collects hardware metrics. All CPU, file system, and network adapter
metrics are available under Hardware Metrics.

The metrics are collected per-minute basis.

Prerequisites

The user is logged on to ESM. These metrics are visible to all the users of ESM
and no specific permissions are required to view them.

Steps
1. LogontoESM.

2. Click Inventory.

Dashboard Inventory Reports Bundles Administration ~ Help

~ Resources

= Invento r:\,"
@&, Discovery Queue
& All Resources
& Platforms From this section, newly discovered Resources, inventoried Resources, and Groups can be vi

B3 Servers - Top Level Imparts

£} Services
& |znored Resources
B3 Unavailable Servers
v Groups
=% All Groups
# Dynagroup Definitions v
22 Compatible Groups
= Mixed Groups

B8 Problem Groups

3. Click Platforms.

4. Select any platform from the list.

1/1553-CNA 403 3115 Uen AM | 2020-11-02 15
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v W1 | 2 esmadmin v

Dashboard Inventory Reports  ~ Bundles Administration  ~ Help

v Resources & Platforms
&, Discovery

& All Resources

B3 Servers -Top Level Imports Name « Ancestry Description Type Version  Avallability .
B3 Servers
Linux Operating Linux
£ Services 8 cloud-db-1 System Linux 2.6.32- @
@ Ignored Resources . .
E3 Unavailable Servers Linux Operating e
B doud-ms-1 . Linux 2632 @
v l-e
Cloies cloud-ms 1 [Platforms, Linux]
*% All Groups =
Al p p— LinUx @
»# Dynagroup Definitions \ ystem
22 Compatible Groups Linux Operating . S
*2 Mixed Groups System e
88 Problem Groups
S esmon Li iLx Operating Linux @
System
D Refresh

5. Select CPU > File System > Network Adapter, and click the Monitoring tab to
view the hardware related metrics to that platform.

k>~ | M1 2 esmadmin v

Dashboard Inventory ~ Reports  ~ Bundles Administration  ~ Help

v B doud-ms-1

£ f i

4 e/ <
{3 Bundle Handler - Ant > Lgp/aev) Shm cene System ) (CR%
{83 Bundle Handler - File Template Tags: @
28 CPUs

Summary nventory Alerts Monitoring

v BE File Systems
Traits Schedules

ih [ 4n [8h [ 12 1d [ 5d [ 1m] 3m| 6m| custom.]  01/23/2017 7:29 am - 01/23/2017 3:20 pm (8 hours)

&) Jericsson/configuration_ma

Avallapllity
{8 fericsson/custom

icsson/enm/alex > 08 AM 09 AM 10AM 1180 12PM 01 pM 0260 03 PM

csson/enm/dumps =

5

{8} fericsson/tor/data Total Rows: 2 (selected: 0)
&} Jetc/opt/ericsson/ERICmod:
N Chart Name Minimum Maximum Average Live Value Alerts
[Y,
E » Free Space 7.7888GB 7.7888GB 7.7888GB 7.8GB 0
& lopericsson/storage/users [ Used Percentage 0% 0% 0% 0% 0
& /software

var/ericsson/ddc_data

var/lib/libvirt

Add to Dashboard : | ESM Default - Add Refresh

Results

The user should be able to view the hardware metrics that are collected by ESM.
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—— RELATED INFORMATION —

7.1 ESM Hardware Metrics on page 17

-
View ESM Hardware Metrics -
-

7.1 ESM Hardware Metrics

The following tables contain the list of hardware metrics that are collected

by ESM.
Table2 CPU Metrics
S.No Metric Name Description
1 System Load Percentage of this CPU running in
system mode
2 User Load Percentage of this CPU running in
user mode
3 Wait Load P/ercentcge of this CPU waiting on
1/0
Table 3  File System Metrics
S.No Metric Name Description
1 Free Space The total free bytes on file system
2 Used Percentage Percentage of disk used
Table4 Network Adapter Metrics
S.No Metric Name Description
1 Bytes received per minute The total number of bytes received
across this network interface since
it started.
2 Bytes transmitted per minute The total number of bytes
transmitted across this network
interface since it started.

1/1553-CNA 403 3115 Uen AM |
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8 ENM Metrics

This section describes the application metrics and common metrics that are
collected by ESM. ESM collects Application Metrics for all the applications
that expose their metrics. These metrics are collected per-minute basis.

The metrics are visible to all the users of ESM, and no specific permissions are
required to view them.

—— RELATED INFORMATION —
8.1 ESM Application Metrics on page 18
8.3 Access ESM Common Metrics on page 32
8.4 Access VM Availability Metrics on page 36

8.5 Access VM Group Availability Metrics on page 36

8.1 ESM Application Metrics

This section describes the Application Metrics that are collected by ESM.
ESM collects Application Metrics for all applications that expose their
metrics. These metrics are collected per-minute basis. These Application
Metrics are visible to all the users of ESM and no specific permissions are
required to view them.

Prerequisites

The user is logged on to ESM.

Steps

1. Click Inventory.

18 1/1553-CNA 403 3115 Uen AM | 2020-11-02
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Bundles

e

v Resources
&, Discovery Queue
4 All Resources
& Platforms
B3 Servers
B3 Servers

-I:I» Services

& |gnored Resources

- Top Level Imports

B3 Unavailable Servers
v Groups
=5 All Groups

# Dynagroup Definitions

= [nventory

From this section, newly discove|

L
= o o
if Compatible Groups
=2 Mixed Groups
s s g
B§ Problem Groups
2. Click Platforms.
3. Select esmon platform.
4. Click ENM Metrics.
Dashboard Inventory v  Reports v  Bundles Administration ~  Help
v & meesmon . .
3 BindleHander= AT > EBENM Metrics (enmmonieoring bata share) D r
48 Bundle Handler - File Template Tags: @
2L Summary  Inventory  Alerts  Monitoring
e Activity Timeline
22 File Systems
> & \S7 Standalone Servers ~|/= @l Resource: Measurements. #|[¢][2][x] [-]l=]® Resource: Alerts #l[elZl[x
This resource has no recent metrics Matching Rows: 0 (selected: 0)
5 Wiy /Boss EAP Patch Handler Creation Time ~ Name Condition Condition Value | Priority Acknowledge Recovered  «
No results found using specified criteria.
=[] Resource: 00B Metrics 2|[8][2][X

No 008 conditions found

EditMode

5. Click ENM Servers.

1/1553-CNA 403 3115 Uen AM | 2020-11-02
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Dashboard Inventory

v B ms-esmon

£ Bundle Handler - Ant

¢33 Bundle Handler - File Template | Tags:

> 28 CPUs al

~ B ENM Server

> B jeatims4352-1_TOR
> B ieatrox2537-1.TOR
> B jeatrexv2538-1_TOR
> B leatrow2539-1 TOR
> B ieatrexs25:

1_TOR

> B ms-esmon_ToR
> B3 openidm_TOR b
> Bsor_ToR

> B3 svc-1-bnsisen_TOR
> B sve-1-cmserv_TOR

> B3 sve-1comecimpolicy T
> B3 svc-1-dehistory_TOR

> B sve-1-dims_TOR
ventbasedclient_

fmalarmprocessin
> B3 svc-1 fmhistory_TOR

> B wur-ifmsany TR 4

Reports

Bundles  Administration v Help

> EBENM MEtrics (enm monicoring pata share )

6. Click any Virtual Machine (VM).

Dashboard

> B sve2-accesscontrol_TOR
> B3 svc-2-bnsiserv_TOR
~ B3 svc-2-dehistory_TOR

B3 svc2-dehistory

c-2-.dims_TOR

alarmprocessin
> B svc-2-fmalarmprocessing.

> B3 svc-2-fmhistory_TOR

> B sve2-mserv_TOR

> B3 sve2fmy_TOR

> B svc-24mpexpserv_T

> B3 svc-2-demserv_TOR

> B3 suc-2-map-service_TOR
> B3 svc-2-medrouter TOR
> B sve2-msem_TOR

> B sve2-mscmee TOR
> B sve2-msemi
> B sve2-msfm_ToR
> B svc-2-mspm_TOR

OR

mssnmpfm_TOR
netex TOR

nodecii TOR
~ B3 sve-2-pmrouterpolicy_TOR

inventory v Repol

Inventory  Alerts Monitoring

Timeline
~|[B/ @ Resource: Measurements #|[5][2)[x] [-][5] ™ Resource: Alerts
This resource has no recent metrics

Creation Time +
- Resource: 00B Metrics ZRIEIX
No 00B conditions found =
Edit Mode Reset
Bundle: Administration Help

> Bfmalarmprocessing Application Metrics (tmaiarmprocessing)

Tags: @
Summary | Inventory  Alerts  Monitoring
Timeline
-1/l @ Resource: Measurements %i0][2] X
278

Number of Ala

Resource: 00B Metrics E

No 0OB conditions found

Edit Mode Reset

7. Click the immediate child resource of the VM.

That is the name of the VM.

Dashboard inventory

Reports

Bundles  Administation v Help

Creation Time =

Matching Rows: 0 (selected: 0)

Name | Condition Condition Vaiue | Priority Acknowledge Recovered

No results found using specified criteria.

ete New Definition

-/[5] P Resource: Alerts 2l Rl[FX

g Rows:

Nal Cong Conditio Priority Acknol Recovered |+

No rasuits found using specified criteria.

> B svc-2-access-control TOR
> B sve-2-bnsiserv_TOR
v B svc-2-dchistory_TOR
5 sve2dchistory
> B sve2-dims_TOR

fmalarmprocessing Application Metrics

> B3 svc-2-fmhistory_TOR
> B sve2-msenv_ToR
» B svc-2fmx TOR

> B sve-2-impexpsenv_TOR
> B sve2-emsene_TOR

> B3 suc-2-map-service_TOR
> B svc-2-medrouter_TOR
> B sve2-mscm TOR

> B sve-2-msemee TOR

» B sve-2-msemip
> B3 svc-2-msfm TOR
k=
> B svc-2-mssnmpfm_TOR
> B svc2-netex TOR

>B

c-2-msj

-2-nodecii TOR

> Bfmalarmprocessing Application Metrics (maisrmprocessing) [Ch:
Tags: @
Summary Inventory Alerts Monitoring
Timeline
2|[0]2/[x] [=|B] ® Resource: Alerts el 7][X]
278 Matching Rows: 0 (selk 0
i yo || CreationTime - Nai Cong Conditiol Priority Acknol Recovered | .
y No resuls found using specified crit
A New Definition
- Resource: 00B Metrics 2|®[2][x]

No OOB conditions found

EditMode Reset

8. Click its immediate child resource.
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Example
fmalarmprocessing Application Metrics

9. Click Monitoring > Metrics to view all the metrics that are collected.

ERHQ

Dashboard Inventory v Reports v Bundles Administration v
» Bfmalarmprocessing Application Metrics  fmatarmprocessing) [CA44
Tags: @
Summary Inventory Alerts Monitoring
Metrics  Schedules
=] larmprocessing TOR
fmalarmprocessing th | 4h | 8h | 121 1d | 5d | im| 3m| 6m| Custom.. 10/14/2016 1:43 am - 10/14/2016 9:43 am (8 hours)
* fmalarmprocessing Application Metrics Avallailiey
o DOWN |
> o2 3 o7
Minimum Maximum Average Live Value Alerts.
» 1 0 0.2872 1 0
, 0 8 ss.0587 8 o
» 0 279 68.3124 279 0
Add to Dashboard - |ESM Default - dd Refresh

10. Unavailability of instrumentation data for more than five minutes of
particular application is shown in red.

Bundies Administraticon

h | &h | Bh | 12 1d | 5d | Bim| 3m| &m| Custom.., TLTEE0NE P30 am - TL 0TS 240 prn (8 hours; ¥ Helresh interval
Avallasility
| | £
o8 1 (selecoed: 0)
hart Name HiremiEn Maximuam fverage Live vame et
 HUMaT of Al Sen T KRS 0 2 a0TER [
Dl

Results

The user is able to access Application Metrics that are collected by ESM.

Note:  For more information on FM application metrics, refer to the ENM
Monitoring System Administrator Guide.

For more information on AMOS application metrics, refer to the ENM
Configuration System Administrator Guide.

For more information on PMIC application metrics, refer to the ENM
Performance Management System Administrator Guide.
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Description of ESM Metrics

Table5 AMOS

S.No Metrics Name Description

1 cpuUsed Current CPU Usage of a virtual

machine.

2 memoryUsed Current Memory Usage of a virtual

machine.

3 sessions Current number of AMOS Sessions

running in the virtual machine.
Table 6 Domain Proxy

S.No Metrics Name Description

1 numberOfActiveCellsCou | Number of active cells
nt managed by domain

proxy.

2 numberOfFailedCbsdRe | Number of failed CBSD
gistrationsIncremental registrations.

3 numberOfFailedConnecti | Number of failed http/tls
onAttemptsWithSasIncr | connections counter for
emental SAS.

4 numberOfInactiveCellsC | Number of inactive cells
ount managed by domain

proxy.

5 numberOfMaintainedGra| Number of authorized
ntsCount grants maintained by

domain proxy.

6 numberOfRegisteredCbs | Number of registered
dsCount CBSDs.

7 numberOfRelinquishedG | Number of grants
rantsIncremental relinquished by domain

proxy.

8 numberOfRevokedGrant | Number of grants
sIncremental revoked. That is

terminated, expired or
auto de-registration
from SAS.

9 numberOfSuspendedGra | Number of grants
ntsIncremental suspended by a SAS.
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S.No Metrics Name Description
10 numberOfTerminatedGr | Number of grants
antsIncremental terminated by a SAS.
11 numberOfValidGrantsCo | Number of valid grants.

unt

DEPRECATED METRICS

1

numberOfActiveCellsCou
nt::domain-proxy-
service

Number of active cells
managed by domain
proxy.

2 numberOfFailedCbsdRe | Number of failed CBSD
gistrationsIncremental:: | registrations.
domain-proxy-
service_trendsUp

3 numberOfFailedConnecti | Number of failed http/tls
onAttemptsWithSasIncr | connections counter for
emental::domain-proxy- | SAS.
service_trendsUp

4 numberOfInactiveCellsC | Number of inactive cells
ount::domain-proxy- managed by domain
service proxy.

5 numberOfMaintainedGra | Number of authorized

ntsCount::domain-
proxy-service

grants maintained by
domain proxy.

Table 7 Fault Management

1/1553-CNA 403 3115 Uen AM

S.No Metrics Name Description
1 activeSubscriptionsCoun | Active FMX
t subscriptions.
2 alarmCountReceivedByA | Number of alarms
PS received by Fault
Management.
3 alarmProcessedByAPS Number of alarms

processed by Fault
Management.

| 2020-11-02
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Table 8 Performance Management

S.No Metrics Name Description

1 combinedNumberOfFiles | Combined ROPs: number
Collected of files collected.

2 combinedNumberOfFiles | Combined ROPs: number
Failed of files failed.

3 combinedNumberOfStor | Combined ROPs: number
edBytes of stored bytes.

4 combinedNumberOfTran | Combined ROPs: number
sferredBytes of transferred bytes.

5 oneMinuteRopNumberO | 1 minute ROP: number
fFilesCollected of files collected.

6 oneMinuteRopNumberO | 1 minute ROP: number
fFilesFailed of files failed.

7 oneMinuteRopNumberO | 1 minute ROP: number
fStoredBytes of stored bytes.

8 oneMinuteRopNumberO | 1 minute ROP: number
fTransferredBytes of transferred bytes.

9 fiveMinutesRopNumber | 5 minutes ROP: number
OfFilesCollected of files collected.

10 fiveMinutesRopNumber | 5 minutes ROP: number
OfFilesFailed of files failed.

11 fiveMinutesRopNumber | 5 minutes ROP: number
OfStoredBytes of stored bytes.

12 fiveMinutesRopNumber | 5 minutes ROP: number
OfTransferredBytes of transferred bytes.

13 fifteenMinutesRopNumb | 15 minutes ROP: number
erOfFilesCollected of files collected.

14 fifteenMinutesRopNumb | 15 minutes ROP: number
erOfFilesFailed of files failed.

15 fifteenMinutesRopNumb | 15 minutes ROP: number
erOfStoredBytes of stored bytes.

16 fifteenMinutesRopNumb | 15 minutes ROP: number
erOfTransferredBytes of transferred bytes.

17 thirtyMinutesRopNumbe | 30 minutes ROP: number
rOfFilesCollected of files collected.
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S.No Metrics Name Description

18 thirtyMinutesRopNumbe | 30 minutes ROP: number
rOfFilesFailed of files failed.

19 thirtyMinutesRopNumbe | 3@ minutes ROP: number
rOfStoredBytes of stored bytes.

20 thirtyMinutesRopNumbe | 30 minutes ROP: number
rOfTransferredBytes of transferred bytes.

21 oneHourRopNumberOfFi | 1 hour ROP: number of
lesCollected files collected.

22 oneHourRopNumberOfFi | 1 hour ROP: number of
lesFailed files failed.

23 oneHourRopNumberOfS | 1 hour ROP: number of
toredBytes stored bytes.

24 oneHourRopNumberOfTr| 1 hour ROP: number of
ansferredBytes transferred bytes.

25 twelveHourRopNumber | 12 hours ROP: number
OfFilesCollected of files collected.

26 twelveHourRopNumber | 12 hours ROP: number
OfFilesFailed of files failed.

27 twelveHourRopNumber | 12 hours ROP: number
OfStoredBytes of stored bytes.

28 twelveHourRopNumber | 12 hours ROP: number
OfTransferredBytes of transferred bytes.

29 twentyFourRopNumber | 24 minutes ROP: number
OfFilesCollected of files collected.

30 twentyFourRopNumber | 24 minutes ROP: number
OfFilesFailed of files failed.

31 twentyFourRopNumber | 24 hours ROP: number
OfStoredBytes of stored bytes.

32 twentyFourRopNumber | 24 hours ROP: number
OfTransferredBytes of transferred bytes.

Table 9  Scripting

S.No

Metrics Name

Description

1

cpuUsed

Current CPU usage of a
virtual machine.
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S.No Metrics Name Description

2 memoryUsed Current memory usage
of a virtual machine.

3 sessions Current number of AMOS
sessions running in the
virtual machine.

Table 16  Configuration Management

S.No Metrics Name Description

1 numberOfSuccessfulSub | Number of successful CM

scriptions Subscriptions.
2 numberOfSupervisedNo | Number of CM
des supervised nodes.

3 numberOfSynchronized | Number of synchronized
Nodes nodes.

4 numberOfSuccessfulSub | Number of successful CM
scriptions::APG-CM- subscriptions.
ROUTER-POLICY

5 numberOfSupervisedNo | Number of CM
des::APG-CM-ROUTER- | supervised nodes.
POLICY

6 numberOfSynchronized | Number of synchronized
Nodes::APG-CM- nodes.
ROUTER-POLICY

7 numberOfSuccessfulSub | Number of successful CM
scriptions::SNMP-CM- subscriptions.
ROUTER-POLICY

8 numberOfSupervisedNo | Number of CM
des::SNMP-CM- supervised nodes.
ROUTER-POLICY

9 numberOfSynchronized | Number of synchronized
Nodes::SNMP-CM- nodes.
ROUTER-POLICY

10 numberOfSuccessfulSub | Number of successful
scriptions::cm-router- CPP CM subscriptions.
policy

11 numberOfSupervisedNo | Number of CPP CM

des::cm-router-policy supervised nodes.
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S.No

Metrics Name

Description

12

numberOfSynchronized
Nodes::cm-router-policy

Number of synchronized
CPP nodes.

13

numberOfSuccessfulSub
scriptions::er6000-
router-policy

Number of successful CM
subscriptions.

14

numberOfSupervisedNo
des::er6000-router-

policy

Number of CM
supervised nodes.

15

numberOfSynchronized
Nodes::er6000-router-

policy

Number of synchronized
nodes.

Table 11 DpMediation Metrics

S.No

Metrics Name

Description

1

numberOfActiveCellsCou
nt::domain-proxy-sas-
handler-code

Number of active cells
managed by domain

proxy.

numberOfMaintainedGra
ntsCount::domain-
proxy-sas-handler-code

Number of authorized
grants maintained by
domain proxy.

numberOfFailedCbsdRe
gistrationsIncremental::
domain-proxy-sas-

handler-code_trendsUp

Number of failed CBSD
registrations.

numberOfFailedConnecti
onAttemptsWithSasIncr
emental::domain-proxy-
sas-handler-
code_trendsUp

Number of failed http/tls
connections counter of
SAS.

numberOfRelinquishedG
rantsIncremental::domai
n-proxy-sas-handler-
code_trendsUp

Number of grants
relinquished by domain

proxy.

numberOfRevokedGrant
sIncremental::domain-
proxy-sas-handler-
code_trendsUp

Number of grants
revoked. That is,
terminated, expired.

1/1553-CNA 403 3115 Uen AM
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S.No Metrics Name Description

7 numberOfSuspendedGra | Number of grants
ntsIncremental::domain- | suspended by a SAS.
proxy-sas-handler-
code_trendsUp

8 numberOfTerminatedGr | Number of grants
antsIncremental::domai | terminated by a SAS.
n-proxy-sas-handler-
code_trendsUp

9 numberOfInactiveCellsC | Number of inactive cells
ount::domain-proxy-sas- | managed by domain
handler-code proxy.

10 numberOfRegisteredCbs | Number of registered
dsCount::domain-proxy- | CBSDs.
sas-handler-code

11 numberOfValidGrantsCo | Number of valid grants.
unt::domain-proxy-sas-
handler-code

12 maxHbResponseTimePe | Maximum time per
rMinute minute taken to receive

heartbeat responses
from SAS.

13 minTxExpiryTimePerMin | Minimum TxExpiryTime
ute per minute given by SAS.

14 numberOfActiveCellsCou | netconf-session-
nt::netconf-session- releaser-handler Number
releaser-handler of active cells being

managed by domain
proxy.

15 numberOfMaintainedGra| Number of authorized
ntsCount::netconf- grants being maintained
session-releaser-handler | by domain proxy.

16 numberOfFailedCbsdRe | Number of failed CBSD
gistrationsIncremental:: | registrations.
netconf-session-
releaser-
handler_trendsUp

17 numberOfFailedConnecti | Number of failed http/tls
onAttemptsWithSasIncr | connections counter for
emental::netconf- SAS.
session-releaser-
handler_trendsUp
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S.No

Metrics Name

Description

18

numberOfRelinquishedG
rantsIncremental::netco
nf-session-releaser-
handler_trendsUp

Number of grants
relinquished by domain
proxy.

19

numberOfRevokedGrant
sIncremental::netconf-
session-releaser-
handler_trendsUp

Number of grants
revoked. That is
terminated, expired.

20

numberOfSuspendedGra
ntsIncremental::netconf-
session-releaser-
handler_trendsUp

Number of grants
suspended by a SAS.

21

numberOfTerminatedGr
antsIncremental::netcon
f-session-releaser-
handler_trendsUp

Number of grants
terminated by a SAS.

22

numberOfInactiveCellsC
ount::netconf-session-
releaser-handler

Number of inactive cells
managed by domain

proxy.

23

numberOfRegisteredCbs
dsCount::netconf-
session-releaser-handler

Number of registered
CBSDs.

24

numberOfValidGrantsCo
unt::netconf-session-
releaser-handler

Number of valid grants.

25

numberOfActiveCellsCou
nt

Number of active cells
managed by domain

proxy.

26

numberOfMaintainedGra
ntsCount

Number of authorized
grants maintained by
domain proxy.

27

deregistrationRequestsC
ount

Number of deregistration
requests to be sent to
SAS.

28

deregistrationResponses
Count

Number of deregistration
responses received from
SAS.

29

EUtranFrequenciesDelet
edCount

Number of EUtran cell
frequencies deleted.
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S.No Metrics Name Description

30 EUtranFrequencyRelatio | Number of EUtran cell
nsDeletedCount frequency Relations

deleted.
31 numberOfFailedCbsdRe | Number of failed CBSD
gistrationsIncremental registrations.
32 numberOfFailedConnecti | Number of failed http/tls
onAttemptsWithSasIncr | connections counter for
emental SAS.
33 grantRequestsCount Number of grant
requests to be sent to
SAS.

34 grantResponsesCount Number of grant
responses received from
SAS.

35 numberOfRelinquishedG | Number of grants
rantsIncremental relinquished by domain

proxy.

36 numberOfRevokedGrant | Number of grants
sIncremental revoked. That is

terminated, expired or
auto de-registered from
SAS.

37 numberOfSuspendedGra | Number of grants
ntsIncremental suspended by a SAS.

38 numberOfTerminatedGr | Number of grants
antsIncremental terminated by a SAS.

39 heartbeatRequestsCount | Number of heartbeat

requests to be sent to
SAS.

40 heartbeatResponsesCou | Number of heartbeat

nt responses received from
SAS.

41 numberOfInactiveCellsC | Number of inactive cells
ount managed by domain

proxy.

42 numberOfRegisteredCbs | Number of registered
dsCount CBSDs.

43 requestsPostedToSASCo | Number of requests
unt posted to SAS.
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S.No

Metrics Name

Description

44

spectrumInquiryRequest
sCount

Number of spectrum
inquiry requests to be
sent to SAS.

45

spectrumInquiryRespons
esCount

Number of spectrum
inquiry responses
received from SAS.

46

frequenciesChangedCou
nt

Number of times change
frequency performed via
DPS.

a7

setCbrsTxExpireTimeCo
unt

Number of times set
CBRS transmission
expire time performed
via DPS.

48

numberOfValidGrantsCo
unt

Number of valid grants.

49

setCbrsTxExpireTimeTi
meRunningTotal

Set CBRS transmit expire
time on cell total time.

50

postRequestToSASTime

Time taken to send
request and get a
response from SAS.

51

getMOFromDPSTime

Time to get MO from
DPS.

52

numberOfFailedAttemps
WithSas

Total number of failed
attempts in contacting
SAS.

53

totalNumberOfHbRespo
nsesFromSAS

Total number of
heartbeat responses
received from SAS.

54

totalNumberOfHbToSAS

Total number of
heartbeats to SAS.

55

totalNumberOfTransmit
ExpiryTimeSetOnNode

Total number of
TransmitExpiry time set
on the node.

56

totalHbResponseTimeFr
omSas

Total time taken to
receive heartbeat
responses from SAS.

57
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S.No Metrics Name Description
response received from
SAS.

58 totalTransmitExpiryTime | Total TransmitExpiry

SetOnNode

time set on the node.

Table 12 Nbalarmirp

S.No Metrics Name Description
1 alarmsSentToNotificatio | Number of alarms sent
nService to NMS.
Table 13 SSO

S.No Metrics Name Description

1 activeSession Number of active
sessions in the system.

2 maxAllowedSessions Max threshold of

allowed active sessions
in the system.

Access ESM Common Metrics

This section describes the Common Metrics that are collected by ESM. ESM
collects Common Metrics for the Virtual Machines (VMs) where JBoss is
running. These metrics are collected per minute basis. The Common Metrics
are visible to all the users of ESM and no specific permissions are required to

view them.

Prerequisites

The user is logged on to ESM.

Steps

1. Click Inventory.
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L

Inventory

Reports

ENM Metrics

\\

Bundles

e

v Resources
&, Discovery Queue
4 All Resources
& Platforms
B3 Servers
B3 Servers

-I:I» Services

& |gnored Resources

- Top Level Imports

B3 Unavailable Servers
v Groups
=5 All Groups

# Dynagroup Definitions

= [nventory

From this section, newly discove|

L
= o o
if Compatible Groups
=2 Mixed Groups
s s g
B§ Problem Groups
2. Click Platforms.
3. Select esmon platform.
4. Click ENM Metrics.
Dashboard Inventory v  Reports v  Bundles Administration ~  Help
v & meesmon . .
3 BindleHander= AT > EBENM Metrics (enmmonieoring bata share) D r
48 Bundle Handler - File Template Tags: @
2L Summary  Inventory  Alerts  Monitoring
e Activity Timeline
22 File Systems
> & \S7 Standalone Servers ~|/= @l Resource: Measurements. #|[¢][2][x] [-]l=]® Resource: Alerts #l[elZl[x
This resource has no recent metrics Matching Rows: 0 (selected: 0)
5 Wiy /Boss EAP Patch Handler Creation Time ~ Name Condition Condition Value | Priority Acknowledge Recovered  «
No results found using specified criteria.
=[] Resource: 00B Metrics 2|[8][2][X

No 008 conditions found

EditMode

5. Click ENM Servers.
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Dashboard Inventory

v B ms-esmon

£ Bundle Handler - Ant

Reports Bundles  Administration v Help

> EBENM MEtrics (enm monicoring pata share )

5 Bundle Handler - File Template. Tags:
> 88 CPUs =
Timeline

~ B ENM Server

> B jeatims4352-1_TOR
> B ieatrox2537-1.TOR
> B jeatrexv2538-1_TOR
> B leatrow2539-1 TOR
> B ieatrexs25:

1_TOR

> B ms-esmon_ToR
> B3 openidm_TOR
> Bsor_ToR

> B3 svc-1-bnsisen_TOR
> B sve-1-cmserv_TOR

> B3 sve-1comecimpolicy T
> B3 svc-1-dehistory_TOR

> B sve-1-dims_TOR
ventbasedclient_

fmalarmprocessin
> B3 svc-1 fmhistory_TOR
> B

Fmsany TOR

6. Clickany VM.

Dashboard inventory v

> & ieatims: _TOR
> B ieatrom2537-1 TOR
> B ieatrexh2538-1_TOR
> B ieatro2539-1 TOR
> B ieatrexh2520-1_TOR
> B3 ms-esmon_TOR

> B3 openidm_TOR

> Bsor_ToR

> B sve-1-access-control_TO
> B sve-1-apsenv_TOR

> B sve-1-bnsiseny_TOR
> B sve-1-cmsery_TOR

> B3 svc-1-comecimpolicy_TC

> B ory TOR
> B sve-1-dims_TOR
> B sve-t-eventbasedciient

E alalmpm(essm

B
> B svc-1-fmhistory_TOR
> B sve-i-imserv_TOR

> B3 sve-1-fmy_TOR

> B3 sve-1-hupd_TOR

alarmproce

> B svc-1impexpserv._]

> B3 suc-1-ipsmserv_TOR

~//2 @l Resource: Measurements. 2o
This resource has no recent metrics
B Resource: 00B Metrics E2IE3
No 00B conditions found
Edit Mode Reset
Reports Bundles  Administration Help

> Bsvc-1-fmalarmprocessing TOR (enm server)

Tags: @
Inventory Aler Monitoring
Timeline
~![B/ @ Resource: Measurements 262
This resource has no recent metrics
= Resource: 00B Metrics BIGK

No 0OB conditions found

Edit Mode Reset

X| [=][3] ™ Resource: Alerts 2l [ol[7][x:

Matching Rows: 0 (selected: 0)

Creation Time + Name | Condition Condition Vaiue | Priority Acknowledge Recovered

No results found using specified criteria.

ete New Definition

iy

(CR44

| []/5] ™ Resource: Alerts 22l

Matching Rows: 0 (seleeted: 0)

tion Time » Name Condition Condition Value | Priority Acknowledge Recovered |

INo resuits found using specified criteria.

7. Click the immediate child resource of the VM.

This displays the name of the VM.

Dashboard inventory

? & ieatims4:
> Bieatro2537-1 TOR

> B ieatrom2538-1

> B3 ieatrexb2539-1_TOR

> B ieatrcxv2540-1_TOR

> B ms-esmon_TOR

> B openidm_TOR

> B sor ToR

> B3 svc-1-access-control_TO
> B suc-1-apserv_TOR

> B sve-1-bnsiserv_TOR

> B sve-1-emsery_TOR

TOR

» B sve-1comecimpolicy_TC

> B swc-1 dchistory_TOR

> B svc-1-dims_TOR

> B sve-1-eventb:

v B s armprocessin
T

> & suc-1 fmhistory_ TOR

> B svc-1-fmserv_TOR

> B sve-1-m ToR

> B suc-1-httpd_TOR

> B svc-1-impexpserv_TOR

> B suc-1-ipsmserv.TOR

dclient_

> B svc-1-tservic

1TIOR

OR v

Reports

Bundles  Administration Help

> Bsve-1-fmalarmprocessingcommon-metries)

Tags:
Summary | Inventory  Alerts Monitoring
Timeline
%/[@][7]ix] [=I[3] # Resource: Alerts %)@ [z]x
e Matching Rows: 0 (selected: 0)
587
o | Creation Time » Name Condition Condition Value | Priority, Acknowledge Recovered -
) Na resuits found using specified criteria
seemare
-5/ @ Resource: 00B Metrics 2|[a][7]1x

No OB conditions found

Edit Mode Reset

8. Click Monitoring > Metrics to view all the metrics that are collected.
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Dashboard Inventory v  Reports v  Bundles Administration v Help
> B ieatims4352-1_10R
> Bieatron2537-1 TOR > B3sve-1-fmalarmprocessing common-metrics) (OR4s
» Blieatron2538-1.TOR Togs: @
> Bieatro2539-1.TOR
> S esmowosa 1 ToR || SUmmary nventory  Alerts Monitoring
> B3 ms-esmon_TOR Metrics  Schedules
> B3 openidm_TOR
> =aliToR in [an[en[ 12 1] 50 [ im] 3m] 6m] Custom.]  09/01/2016 9:40 am - 09/01/2016 5:40 pm (8 hours) o
> B3 sve-1-access-control_TO
Avallaniiity
| |
N Iy A 120m o150 - 025 "
B 4selected:0
Chart Name Minimum Maximum Average Live Value Alerts

> B sve-1 eventbasedcliznt. b VAmsAwraw Heap Memory Used 630.1 B 8134 M8 7478 MB 0
w E3 svc-1-fmalarmprocessin ¥ Open File Descriptor Count 587 587 587 0

svet-imalamproce G Process CPU Load 0.0076 0.016 0.0087 0
> B3 svc-1 fmhistory_TOR » Thread Count 451 452 451.0083 0

Add to Dashboard : [ESM Default - Add Refresh

9. Unavailability of instrumentation data for more than five minutes of a
particular application is shown in red.

Dashboard

Results

The user is able to access Common Metrics that are collected by ESM.

8.3.1 ESM Common Metrics

The following table contains the list of Common Metrics that are collected
by ESM.

Table 14 Common Metrics

S.No Metric Name Description

1 Heap Memory Used The amount of used memory that
is used by Java virtual machine

2 Open File Descriptor Count The count of Open File
Descriptors. A file descriptor is an
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S.No

Metric Name

Description

abstract indicator used to access a
file or other input/output resource,
such as a pipe or network
connection.

Process CPU Load

The percentage CPU usage for the
Java Virtual Machine process.

Thread Count

Number of threads of execution

Access VM Availability Metrics

ESM collects metrics for VM availability. It displays the availability of a particular
VM in the form of 1's and @'s. 1 indicates VM is available, @ indicates VM is

unavailable.

These metrics are visible to all the users of ESM, and no specific permissions are
required to view them.

Prerequisites

The user is logged on to ESM.

Steps

1. Click Inventory.

Click vm Avadilabilities > Vm Availability.

2. Click Platforms.

3. Selectms platform
4.

5. Click any VM.

6.

00 &

v & vm Availabilities

v B vm Avallability

>3

Access VM Group Availability Metrics

in[4n[sn| 124 1d [ 5d | 1m] 3m| 6m][ custom.

larmprocessings

22 ymimhistories

Schedules

Avallabliity

11/13/2017 7:56 am - 11/13/2017 3:56 pm (8 hours)

Click Monitoring > Metrics to view all the metrics that are collected, which
indicates the availability of a particular VM.

@ warflog

ESM collects metrics for VM Group availability. It displays the availability
percentage of a similar type of VM's running on different blades. The percentage
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is computed based on the number of active instances of a VM out of total

deployed instances.

P
>

These metrics are visible to all the users of ESM and no specific permissions are

required to view them.

Prerequisites

The user is logged on to ESM.

Steps
Click Inventory.
Click Platforms.

Selectms platform.

A W nNoE

5. Click any VM.

Click vm Group Availabilities.

6. Click Monitoring > Metrics to view all the metrics that are collected.

Tags: @

Avallanliity

B3 fmalarmprocessing
£ fmnistory
2 mserv
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Summary nventory  Alerts
Metrics Schedules

ih[4n[8n|12q 14 [ 5d [ im| 3m][ 6m| custom. 11/13/2017 8:07 am - 11/13/2017 4:07 pm (8 hours)

~ Refresh Interval

1260 orem ozem 03PM

Total Rows: 1 (selected: 0)

Minimum Maximum Average Live Value

100% 100% 100% 100%

Alerts

0
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9 View Resource Metrics

ESM users can view the metrics for a specified resource.

Viewing metrics for a specified resource is available for the three default ESM
Users. They are collected on a per-minute basis.

Prerequisites

The user is logged on to ESM.

Steps
1. LogontoESM.

2. Click Inventory.

>~ | W1 | 2 esmadmin v

Dashboard Inventory - Reports Bundles Administration  ~ Help

v Resources

Inventory

QDIS(OVG? Queus

& All Resources

& Platforms From this section, newly discovered Resources, inventoried Resources, and Groups can be viewed and managed.
B3 Servers - Top Level Imports

B3 Servers

£} Services

@ Ignored Resources

B3 Unavailable servers
v Groups
*% All Groups
# Dynagroup Definitions »
22 Compatible Groups
=3 Mixed Groups

88 Problem Groups

3. Click Platforms.

4. Select any platform from the list.
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%~ | W1 % esmadmin ¥

Dashboard Inventory Reports v Bundles Administration ~ Help

v Resources E Platforms

& All Resources

ows: 5 (selected:

B3 Servers - Top Level Imports Name = Ancestry Description Type Version  Avallability «
. Linux
Linux Operating. ;. 2632 @
system 504.54.1.¢
@& Ignored Resources S
Unavailable Servers Linux Operatin, (.3
E3 Unavailable Servers sy Linux 2632 @
v Groups £ 504.54.1.¢
Linux
*2 All Groups Linux Operatin] B
. P & cdoud-svc-1 . " % Linux 2632 @
# Dynagroup Definitions b | 504.54.1.€
22 Compatible Groups ) Linux
- = Linux 2632 @
*2 Mixed Groups tel
sysem 5025416
B8 Problem Groups [ Linux
B esmon Sysem P % Linux 2632 &
o 504.54.1¢

gnore Refresh

/coregui/#Resource/10782
T T

T = T ——— W T

5. Click Monitoring > Metrics to view all metrics collected for this platform.

*~ W1 2 esmadmin v

Dashboard Inventory Reports v Bundles Administration v Help

clou

63 Bundle Handler - Ant

> Ecloud-sve-T (unux &

&% Bundle Handler - File Template Tags: &

> B2 CPUs
Summary Inventory Alerts Monitoring Events Operations Drift Content
22 File Systems

Traits Schedules

> B2 Network Adapters
> BB RHQ Agent

85 Wildfly/]Boss EAP Patch Handler 1h | 4h | 8h | 12 1d | 5d | 1m| 3m| 6m| Customn. 01/23/2017 7:31 am - 01/23/2017 3:31 pm (8 hours)

Avallapliity

>
| Total Rows: 9 (selected: 0)

Chart Name Minimum Maximum Average Live Value Alerts

» Actual Free Memory 453GB 1124 GB 49.5 GB 45.6 GB ] -

¥ [T Acwal Used Memory 1.8GB 68.9GB 64.7 GB 68.6 GB 0

» Free Memory 326GB 111.9GB 37.1GB 328GB 0 =

o Free Swap Space 5GB 5GB 5GB 5GB o

P Idle 348% 81.7% 58.4% 501 % 0

» System Load 33% 153% 134% 181% o .
Add to Dashboard : | ESM Default ~ Add Refresh

Note: CPU Metrics in ESM GUI and server do not match as the CPU
metrics continuously change.

6. Select a child resource from the list on the left to view information specific to
that resource.
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Dashboard Inventory

cloud-svc

Bundle Handler - Ant

8% Bundle Handler - File Template

v B8 CPUs

&HCPUO

#CPUT

#CPU 0
&erPunt
@epPu2
#CPUI3
@BePu2
&HCPU3
& CPU4
#CPUS
@erus
&CPU7
@CPUs
#CPUY

~

2 File Systems

v

% Network Adapters

Reports v

Bundles Administration

> Bcloud-svc-1 cunux

Tags: ©
Summary Inventory Alerts
Metrics Traits schedules
1h | 4h | 8h | 12n 1d | 5d | 1m| 3m| 6m| Cus

Avallabllity

5 08 A
Chart Name

3 Actual Free Memory

» T Actual Used Memory

4 Free Memary

L Free Swap Space

P Idle

- Help

Monitoring

tom..|

Total Ro
Minimum Maximum
453 GB 1124 GB
1.8GE 68.9GB
326GB 1119 GB
5GB 5GB
348% 81.7%

Events

* v

™1 L esmadmin v

Operations Drift Content
01/23/2017 7:31 am - 01/23/2017 3:31 pm (8 hours)

12PM 01PM 03 PM

Average Live Value Alerts
456 GB 0 =

647 GB 68.6 GB 0
37168 32868 0 =
5GB 5GB o
584% 59.1% 0

7. Click the black arrow next to each metric to display a graph of metric

readings over time.

Dashboard Inventory v Reports

chart

P Patch Handler

Summary

Bundles Administration  ~

Help

Inventory Alerts on
Trans 5S¢t
8n|1 d || 5d | 1m| 3m| sm| Custom
Avallability
e
oo | |
E} 0334

Name Minimum

System Load

9.6202%

CPU Q- System Load

EN 0335

Total Rows: 3 (selected: 1)

Maximum

9.6802 %

Average

9.6802%

v | W1 L esmadmin v

Live value Alerts
79% ]
404% a
o o

8. Usethelh,4h,8h, 12 hbuttons to choose the appropriate time range.

The following graph shows the same metric as the one above, but using a
different time range (1d - last day).
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P
>

A esmadmin

Dashboard Inventory ~  Repors v Bundles Administration

undle Handler - Ant SCPU Otcruy
undle Handler - Fle Template | Tags: =
summary  Inventory  Alerts ng

Sche

1d|[5d 6m|[ custom o1/ 3:38 pm (an hour)

233pm

Avallabllity

Total Rows: 3 (select

Chart Name Minimum Maximum Average Uve Value Alerts
- 133% ] 4% o
= E
3 0
3 ]
- A Refresh
T T T T T =T " T

1 | A esmadmin «

Dashboard Inventory v Reports ~  Bundles Administration ~

> & CPU O(cruy

er-FleTemplate | Tags: ®

Summary  Inventory

1d|[ 5d

6m| custom 0

7238 pm- 0

3:38 pm {an hour)

A\la\lahl\lw
oo 7]

Total Rows: 3 (selecn

Chart Minimum Maximum Average Live Value Alerts

0.6024 % 102% 0

8500 % 11.445:

3 user

3 walt Load

Default ~ Add Refresh
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10 Enabling and Disabling Metrics of a Specific
Resource

Metrics can be enabled and disabled for a specific resource.

The enable operation is performed when the user wants to collect a specific
metric for a resource. The disable operation is performed when the metrics for a
particular resource are no longer required.

Prerequisites

The user is logged on to ESM. Enabling/disabling of metrics can be done by an
administrator.

Steps
1. LogontoESM
2. Click Inventory.

3. Select the resource type in the Resources menu on the left and browse/
search for the required resource.

> | W1 2 esmadmin v

Dashboard Inventory Reports v Bundles Administration ~ Help

v Resources

Inventory

@), Discovery Queue
& All Resources
& Platforms From this section, newly discovered Resources, inventoried Resources, and Groups can be viewed and managed
EJ Servers - Top Level Imports
B3 Servers
£} Services
& Ignored Resources
B3 Unavailable Servers
v Groups
*% All Groups
# Dynagroup Definitions
22 Compatible Groups
*2 Mixed Groups

B8 Problem Groups

4. Click the Monitoring tab on the resource entry.
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5. Click Schedules.

6. Select the metrics to enable or disable.

W1 2 esmadmin v

Dashboard Inventory Reports  ~ Bundles Administration
.
£ Bundle Handler - Ant > BEcloud-ms-T cunw @ 5
8% Bundle Handler - File Template Tags: @
3 cpus ;. - ,
Summary nventory Alerts Monitoring Events Operations Drift Content
> B8 File Systems
Metrics Traits

> B8 Network Adapters

> BB RHQ Agent
8} Wildfly/|Boss EAP Patch Handler Total Rows: 18 (selected: 0)
Metric « Description Type Enabled?  Collection Interval -

The actual total free system memory (includes =
Actual Free Memory unallocated memory as well as available buffer and measuremel ¥ 10 minutes
cache memory)

The actual total used system memory (includes

Actual Used Memory measureme ¥ 10 minutes =
buffer and cache memory)
Architecture Hardware architecture of the platform trait v 24 hours
Distribution Name name of the Linux distribution trait 4
\ version of the Linux distribution trait L
Free Memory lT)I:J;!‘f[t-E'Er ;ii?::;;l;mm}' (doesnotindude measureme| ¥ 10 minutes
Free Swap Space The total free system swap measureme ¥ 20 minutes
Hostname Mame that this platform is known as trait L 24 hours
Idle Idle percentage of all CPUs measuremel ¥ 20 minutes M

Collection Interval : minutes - Set

Refresh

Results

Metrics for a specific resource are disabled or enabled.
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ENM System Monitor Alerts

ESM can collect, analyze, and alert on the data that it collects. Alert definitions
can be created on every resource and metric combination in the system; for
example, it is possible to create an alert on CPU 1 of svc-1 for the System Load
metric.

The application recognizes two main types of alarms: alerts that are internal to
ESM and FM alarms that appears in ENM Fault Management system. Internal
alerts are visible to all users of ESM but are not shown in any other part of ENM.
ESM is capable of forwarding its alerts to ENM Fault Management as Alarms.
Alerts that are forwarded appear both in ESM and in FM.

An Alert Definition is made up of a number of characteristics.

General Properties
The following general properties are associated with the alert:

— Name: human-readable name.
— Description: textual description.
— Priority: severity level.

— Enabled: whether the alert is currently enabled.

Conditions

A set of conditions that cause the system to raise this alert.

— Fire alert when: whether the alert should fire when ALL of the listed
conditions are satisfied or if ANY one is satisfied.

Notifications

A list of notifications that the system sends out in addition to displaying the alert
on the ESM dashboard.

Recovery

Not supported in ESM.

Dampening

Not supported in ESM.
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Table 15 Conditions Types
S.No Condition Type Description
1 Availability Change Monitor the availability of a
resource and alert when it enters a
specific state, for example "goes
down".
2 Availability Duration Monitor the availability of a
resource over a specified duration.
3 Measurement Absolute Value Alert when the value of a metric is
Threshold below, at, or above a specific
value.
4 Measurement Baseline Threshold | Alert when the value of a metricis
below, at, or above a specific
baseline expressed as a
percentage.
5 Measurement Value Change Alert when the value of a metric
changes.
6 Measurement Value Range Alert when the value of a metric
falls within the specified range.
7 Trait Value Change Alert when a trait of a resource
changes to the specified value.
Table 16  Notifications Senders
S.No Condition Type Description
1 FM Alert Raise an alarm in ENM Fault
Management.
2 FM Clear Alert Clear a previously raised alarm in
ENM Fault Management.
Table 17  Alert Severity Mapping ESM GUI and FM Alarm Monitor
S.No ESM GUI FM Alarm Monitor
1 Low Minor
2 Medium Major
3 High Critical
—— RELATED INFORMATION —

11.1 View Alert Information on page 46

11.2 Create FM Alert Notifications on page 48

11.3 Create Internal Alerts on page 58

11.4 Update an Existing Alert on page 62

11.5 Delete Alert Definition Template of a Given Resource on page 63
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View Alert Information

Alerts are raised when a metric meets the threshold value specified in the
conditions of alert definition.

All users can view this alert information.

Prerequisites

— The user is logged on to ESM.

— Anadlert has been raised by the system.

Expected Result

You can view information related to alerts and the affected resources.

Steps
1. LogontoESM
2. Click Dashboard.

3. Locate the Recent Alerts view.

Condition Value Priority Acknowledge Recovered  Resource
125GB -

° 12568 [

4. Toenable Recent Alerts, if the view is not displayed:

a. Click Edit Mode located on the top-right corner of the screen.

] 2 esmadmin +

| Edit Mode || New Dashboard

b. Select Add Portlet > Recent Alerts.

1/1553-CNA 403 3115 Uen AM | 2020-11-02



-
ENM System Monitor Alerts -
/ -

Dashboard Inventory Reports v Bundles Administration v Help

ESM Default
Dashboard Name : [ESM Default Add Portlet « | Columns: 2 | Add Column || Remove Column || B

Inventory Summary Alerted or Unavailable Resources g

Discovery Queue

Platform Total - Favorite Groups
Favorite Resources

Server Total : i
Inventory Summary me ~ Name G

Service Total : Mashup s
[lc
- Message AM  Linux - Idle
Compatible Group Total : I i 9]
Platform Utilization int
Mixed Group Total : Recent Alerts M
Group Definition Total - Recent Events DM Linux - Idle - Clear ['C
k]
. Recent Operations -]
Average Metrics per Minute : e

Recently Added Resources

esource Group Metric Graph (=

esource Metri ph
Platform Utilization l Unavailable Resources

Scheduled Operations
Tag Cloud
Total Rows: 5 (selected: 0] Timeline
ReEsUUILE

Name Avallability Version  CPU Memory | Swap

£ |/ cloud-ms-1

c. Click View Mode located on the top-right corner of the screen.

5. Double-click on any alert listed on the Recent Alerts portlet to view its

details.
= O Recent Alerts 222X
Matching Rows: 3 (selected: 0)
Creatlon Time ~| Name Condition Text Condition Value Priority Acknowledge Recovered | Resource -
Metric Value Range: ~|F
. . [Idle] between [16.0 - . N
2/2/17 3:44PM  Linux - ldle - Clear 414 cloud-ms-1
e %] and [100.0 %], ' =
inclusive
Metr le Range: _
2217324 PN Linux - 1die licie] between [0.0-, g4 - cloud-ms-1
%] and [5.0 %],

inclusive -

6. The details shown include general properties, thresholds, and recorded
values, and notifications that are triggered as a result.
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Create FM Alert Notifications

The user can see the raised FM Alert on Alarm Monitor page by creating
ESM alerts that are forwarded to ENM FM Alarm Monitor.

Prerequisites

User is either an esmadmin or esmalertadmin. Only esmalertadmin and
esmadmin users are allowed to perform this task.

To monitor a resource with FM Alarm escalation and de-escalation, multiple
alerts (including a clear alert) with different priorities have to be set up in ESM.

Each time an alert is raised, that particular alert is disabled and all other alerts on
that resource metric are enabled. This is done to avoid raising multiple alerts on a
single, continued threshold breach.

There is only one alarm created at the FM side on a particular metricon a
particular resource, whereas there is one alert raised at the ESM side for each
priority of that metric. The same alarm at FM is escalated, de-escalated, or
cleared based on the condition met.

Every FM Alarm raised from ESM can be found in the ESM Alert History tab on
the Alerts page.

To forward an ESM alert to FM as an alarm, the user must set its General
Properties, Conditions, and Notification details.

Example

— This example goes through the process of creating an FM Alarm on a file
system resource /dev/shm (on its Used Percentage metric).

— Four alert types are covered: Low, Medium, and High priority alerts as well as
a Clear alert.

— The following thresholds are used:

— Low: 50% to 70%

— Medium: 70% to 90%
— High: 90% to 100%
— Clear: 0% to 50%

When the Used Percentage is within the given threshold, a
corresponding alert is raised.
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Steps

1. Logonto ESM as esmadmin or esmalertadmin user.

2. Click Inventory.

3. Click Platforms.

4. Select esmon.

5. Select esmon > File Systems > /dev/shm on the sidebar.

6. Click Alerts.

X esmadmin ¥

Dashboard Inventory Reports Bundles Administration ~ Help
v B esmon o i
) Bundle Handler - Ant » 65/ dev/Shim (ee system) G
£ Bundle Handler - File Template Tags: B
Dles Summary nventory Alerts Monitoring
> B3 ENM Merrics
~ 5 File Systems Definitions History
@&/
3 /boot Total Rows: 6 (selected: 0)
= onfenmidumps Name Description Creation Time  Modified Time Enabled Priority Parent Protected

File System Threshold Jan 21,2017 Jan 21,2017
exceeded 3:40:55 AM 3:40: M

son/ddc_data

@ - View Template No

@8 son/esm_ddc_data e — — P — P—
N ) e System Thresho Jan 21,2017 Jan 21,2017 View Template
& sDoi/esmEcata exceeded 3:40:55 AM sa0ssam O ®  ViewTemplate te
b H Standalone Servers System M an 21 2017 an 31 3017
J a F e;_,:l.ml ade J;ﬂAM f:{“\f Jmfl_fﬁj\/ o - Template o
3 B2 e dapters Changed 3:40:55 AM 3:40:55 AM
File System Mode Jan 21, 2017 Jan 21, 2017 .
> BB RHQ Agent N i N . fiew Template N
g Changed 3:40:55 AM sdpssam D s °
> 88 RHQ Storage Nodes File System Threshold  Jan 21,2017 Jan21,2017 o ew Template No
£5% Wildfly/|Boss EAP Patch Handler exceeded 3:40:55 AM 3:40:55AM SR
File System Threshold Jan 21,2017 Jan 21,2017 @ } View Template s

exceeded 3:40:55 AM 3:40:55 AM

“ Enable Disable Delete Refresh

7. Click New to create a new alert.

8. Enter the required name of the Alert in the Name field and fill in the
description.

For example, see the Create Alert for Disk Space on page 50.
9. Select the required priority level from the drop-down list.

10. Create a Clear alert by using the clear tag, prefixed by Name (MetricName -
Clear).

For an example, see Create Clear Alert on page 54.
11. ESM enables users to Acknowledge and Delete the alerts in the ESM GUL.

Acknowledging and Deleting the alerts in ESM GUI does not modify alarms
state in FM alarm monitoring GUI.
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Note: OPIs are not available for User Created Alerts.

Results

The alerts are displayed on the ESM Dashboard and ENM FM Alarm Monitor
page if the thresholds are breached.

11.21 Create Alert for Disk Space

The following example shows how to create an alert for a disk space
scenario.

1. EnterLow on free spaceinthe Name field, /dev/shm is low on free
space in the Description field, and select Low from the Priority drop-down
list.

» $63/deV/SNM (il system)

Tags: &
summary nventory Alerts Monitoring
Definitions History
I
« Back to List
General Properties Conditions Motifications Recovery Dampening
Mame : |Low on free space
Jdev/shm is low on free
space
Description :
Priority - | m Low -
e Yes
Enabled :
Mo

Note: Itis mandatory to fill the Description field as it represents the
Specific Problem in FM Alarm.

2. Click the Conditions tab.
3. Click Add.
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4. Select Measurement Value Range in the Condition Type field, Used
Percentage from the Metric drop-down list, and Inside, Exclusive from the
Comparator drop-down list. Enter 50 to the Low Value field and 70 to the
High Value field.

Add Condition

Condition Type : | Measurement Value Ftange|3

Compares a metric value to a given low-high
value range.

Metric |U5€-d F’e;cemage|£|

Comparator : | Inside, exclusive | -

Low Value: 50

High Value: 70
Base Units : ¥

B o

Click OK.
Click Notifications.

Click Add.

© N o u

Select FM Alert from the Notification Sender drop-down list and then click
OK.
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(D Alert definition successfully created X

Add Notification

Notification Sender : |FM Alert -

OK || Cancel

Note: Except for FM Alert and FM Clear Alert, the other options in drop
down are not supported.

9. Click Recovery.
10. Select the Yes for Disable When Fired.

* M2 | 2 esmadmin v

Dashboard Inventory Reports v Bundles Administration v Help
~ E esmon )
& Bundle Handler - Ant > {é}/de\//shm(ﬂlesystam) O
{8} Bundle Handler - File Template Tags: &
> 58 CPUs
Summary Inventory Alerts Monitoring
> B3 ENM Merrics
~ 55 File Systems Definitions History
&/
£ /oot « Back to List

Jfdev/shm

48} fericsson/enm/dumps

General Properties  Conditions Notifications Recovery Dampening

& /var/ericsson/ddc_data Recover Alert : | - None - -
483 var/ericsson/esm_ddc_data ® Yes

. » Disable When Fired

{83 fvar/ericsson/esm-data © No

> &2 JBossAST Standalone Servers
> 28 Network Adapters
> EBRHQ Agent
> 88 RHQ Storage Nodes
£83 Wildfly/|Boss EAP Patch Handler

11. Click Save to store this alert.

12. Click Back to List to return to the list of alerts.
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13. Follow the same procedure to create Medium and High priority alerts.

Only the Priority and Low/High values are changed.

Example 1 Medium Priority Alert

Add Condition

Condition Type : |Meaﬁuremem Value Range|z|

Compares a metric value 1o a given low-high
value range.

Metric |Used F’ercentage|£|

Comparator : |In5ide, exclusive | - |

Low Value: 70

High Value: o0
Base Units : %4
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Example 2 High Priority Alert

Edit Condition

Condition Type : | Measurement Value Ftange|3

Compares a metric value 1o a given low-high
value range.

Metric |U5¢-:-d Percemage|3

Comparator : | Inside, exclusive |Z|

Low Value: 90

High Value:

Base Units - 4

11.2.2 Create Clear Alert

The following example shows how to create a Clear alert.

1. Set the Priority to Low and Enabled to No in the General Properties tab.

2. When adding a new condition, enter @ to the Low Value field and 50 to the
High Value field.

3. Inthe Notification tab, select FM Clear Alert from the Notification Sender
drop-down list.
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Add Notification

Notification Sender : | FM Clear Alert) =

OK || Cancel

4. Foreach alert, select the Yes for Disable When Fired in the Recovery tab.

Results

With all the steps completed, the Alerts > Definitions tab for that resource is
displayed as shown in the following image.

> {&/dev/Shm (rue system)

plate

View Alarm on FM

To view the alarm on FM, do the following steps.

Prerequisites

The user is logged into the ENM launcher page as an administrator.
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Steps

1

Open the Alarm Monitor from the ENM launcher page.

2. Open Network Explorer > Search for managementsystem > Select ENM
Object > Return Selected managed object.
3. Click Select on ENM and then Apply.
Example
3416 8:46AM  Low on free space Z'ﬂ“;”sﬁ‘ucg"e'g]mw“ 11968 -
Figure 1 FM Alert Notification Displayed in ESM
Example
@upv &
Figure 2 FM Alert Notification Displayed in ENM Alarm Monitor
Results

Once a Clear alarm is sent from ESM, its Alarm State in Alarm Monitor changes to
CLEARED and user can remove it from the list by acknowledging it as shown in the
following figure:

Z Ericsson Network Manager

Alarm Monitor
B | Jeon a

Network x
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Example 3 Before Deletion

Marching Rows: 479 (selected- 1)

Creation Time »| Name Condition Text Condition Value

Sample Alert

Metric Value Range:
[Used Percentage]
18/5/16 12:51 PM Sample Alert between [0.0 %] 1.0% =

Delete
Figure 3 Alert ON ESM GUI

Alarm Monitor

A Export Add Comment + Acknowledge | | X Clear GoTo.w | View Summary Clear Selection
L | | )| L | 4o il ) | L
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Priority Acknowledge Recovered

Resource

Jericsson/configuration_ma

Mvarfericsson

L -

\\

e

m

Ko Mo o W1 MO @0

Selected (1)

Network x ad P G Alarm Summary x
Linux) ieatrcxba371-1 - (File... ‘Sample Alert ALARM
| B AddTopology Data v L ! ¢ f2 Severity: MAJOR o~
(Linux)ieatrcxba371-1 - (File..  Sample Alert ALARM
Applied Network Elements Record type
Applied 1 of 1. Show All Objects (Linux) ieatrcxba37114 - (File...  Sample Alert ALARM i
e Previous Severity
[Tvpe to Find nodes | Fnd | (Linux) ieatrcxba371-1 - (File...  Sample Alert ALARM UNDEFINED
ENM (Linux) ieatroxb4371-1 - (File...  Sample Alert ALARM e s
| Remove All Applied | (Linug) ieatrcxba371-1 - (CP...  TestAlert ALARM EventType
e — sample Alert
(Linux) ieatrexb4371-1 - (CP... TestAlert ALARM
Specific Problem
- (Linuz) ieatrcxbd371-1 - (File System)
(Linux) ieatrcxba3711 - (CP...  TestAlert ALARM Jericsson/configuration_managemeni/Upgra
delndependence -
(Linux) ieatrcxba371-1 - (File...  Sample Alert ALARM
Probable Cause
(Linux) ieatrcxb4371-4 - (CP...  TestAlert ALARM ickciadgarait
(Linux) ieatrcxb437141 - (CP...  TestAlert ALARM Acknowledge Time
(Linux) ieatrcxb4371-1 - (CP...  TestAlert ALARM Cease Time
N Object Of Reference
(Linux) ieatrexb4371-1- (CP...  TestAlert ALARM bt
< )v
C_! Recent Alerts
Matching Rows: 478 (selected: 0)
Creation Time » Name Condition Text Condition Value Priority, Acknowledge Recovered  Resource -

Metric Value Range:
[Used Percentage]
8/5/1612:51 PM Sample Alert between [0.0 %] 1.0% =
and [70.0 %],
exclusive
Metric Value Range:
[Used Percentage]
8/5/16 12:51 PM Sample Alert between [0.0 %] 30% =

Acknowledge Delete

Figure5 ESM GUI
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Ericsson Network Manager / Alarm Qverview » / Alarm Monitor

Alarm Monitor

B|  JSeworn | @Badd Comment ~ Acknowledge | X Clear T
Ko Meo o W o @o
Network x Probable Cause

B Add Topology Data v

Applied Network Elements
Applied 107 1. Show All Objects

Find

ENM

Remove All Applied

Figure6 FM GUI

Create Internal Alerts

This section describes how to create internal ESM alerts.

View Summary

Specific Problem

(Linux) ieatrcxbd371-1 - (File...
(Linux) ieatrcxbd371-1 - (File...
(Linux) ieatrcxb4371-1 - (File...
(Linux) ieatrcxbd371-1 - (File...
(Linux) ieatrcxbd371-1 - (File...
(Linux) ieatrcxb4371-1 - (CP...
(Linux) ieatrcxb4371-1 - (CP...
(Linux) ieatrcxb4371-1 - (CP...
(Linux) ieatrcxbd371-1 - (File...
(Linux) ieatrcxbd371.1 - (CP...
(Linux) ieatrcxb4371-1 - (CP...
(Linux) ieatrcxb4371-1 - (CP...

(Linux) ieatrcxbd371-1 - (CP...

Clear Selection

Event Type
Sample Alert
Sample Alert
sample Alert
Sample Alert
Sample Alert
TestAkrt
TestAlert
TestAlert
Sample Alert
TestAkrt
TestAlert
TestAlert

Test Alert

T % 3

Selected (1

Alarm Summary x

ESM Service, (Linux) ieatrcxb4371-1 - (File ©
system)

lericsson/configuration_management/Upgri

Sp blem
(Linux) teatrexb4371-1 - (File System)
Jericsson/configuration_managementUpgra
delndzpendence -

Only esmalertadmin and esmadmin user types are allowed to create, edit, and
delete Alerts. Alerts can be created on any resource. These alerts are triggered
only when the threshold value is breached.

Note: The alert described in this section does not appear in the FM Alarm
Monitor tool, it is local to ESM.

Prerequisites

— The user is esmadmin or esmalertadmin and has the correct access rights.

Steps

1. Logon tothe ENM System Monitor GUL

2. Click Inventory > All Resources.
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v & cloud-svc-2
{o» Bundle H:
{o} Bundle H:
sz CPlUs

“ 5 File Syster

{e} /boot
{o} /dev/s
{o} /ericss
{o} /ericss
{o} /ericss
{o} /ericss
{o} /ericss
{o} /ericss
{o} /ericss

{o} /ericss

3. Select a resource from the list.

4. Click New.

\\

ENM System Monitor Alerts

Inventory

Repor

Discovery Queue

All Resources

Platforms

Servers - Top Level Imports
Servers

Services

lgnored Resources

Lnavailable Servers

All Groups

Dynagroup Definitions
Compatible Groups
Mixed Groups

Problem Groups

5. Enter Name, Description, and select Priority on the General Properties tab.
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? {ﬁ:’}."‘ ( Flle System )

Tags: [
SLJI'I'II'I‘IEH‘},-r Inuen[t::rj,.r Alerts Mcrnit::uring
Definitions History

« Back to List

General Properties Conditions MNotifications

Mame : [Sample Alert

user guide.
Description :
Priority : | m Low -
" Yes
Enabled :
i) Mo

6. Click Conditions.

7. Choose when to fire the alert: when all conditions are true, or if any one is
true.

General Properties Conditions Notifications Recovery Dampening

Fire alert when : | ANY -

ANY Total Rows: 0 (selected: 0)
ALL
Condition

No items to show

8. Select Add to add a new condition.
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9. Select a condition type, if applicable select the metric and enter a threshold
value.

Note:  All the resources may not have the same list in Condition Type drop-

down. They may vary from one resource to another based on the
metrics that are collected for that particular resource.

For example, if the Metric collected for a resource is only Availability then the
Condition type drop-down only contains Availability Duration and
Availability Change.

Add Condition X

Condition Type : | Measurement Absolute Value Threshold| -

Specify the threshold value that, when violated, triggers the
condition. The value you specify is an absolute value with an
optional units specifier.

Metric : | Free Space| =
Comparator : | < {Less than) -
Metric Value: 500
Base Units : KB

Note: The Metric Value Range while defining an internal alert the default
thresholds for CPU, Heap Memory, Total Memory are in Bytes
instead of %.

10. Click OK to add the condition, Cancel to discard it.
11. Click Save to add the new Alert, Cancel to discard it.
Results

Note: There may be a delay in raising threshold alert. Click monitoring tab to
raise an alert if there is delay.
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11.4 Update an Existing Alert

This section describes how to edit (update or disable) an alert that is
already created.

Only the administrator and Alert administrator can update an existing alert.

Prerequisites

— The user is logged on to ESM.

— Analertis already created.

Steps
1. Select a pre-existing alert.

2. Click on Edit.

>$0CPU 1 (cpu)
Tags: &
Summary Inventory Alerts Vlcmtorlr‘-g

Definitions History

General Properties Conditions Notifications Recovery Dampening
Fire alert when : ANY

Total Rows: 1 (selected: 0)
*

Condition

Metric Value Range: [System Load] between [90.0 %] and [95.0 %], exclusive

3. Enter the values which you wish to change under General Properties >
Conditions > Notification > Recovery tabs.

Note: Changing the value of name, priority or description leads to

inconsistent behavior. It is strongly recommended not to change
these fields for default alert definitions.
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4. Click Save.

Edit Condition

Condition Type : | Measurement Value Rangefﬂ

Compares a metric value to a given low-high
value range.

Metric - IrU sed Percenta geiq

Comparator : | Inside, exclusive - |

Low Value : 90
High Value : [o5
Base Units : KB

N o

Note: Thereis a limitation while editing the Condition of Alert. Editing
Condition does not display the proper base unit.

During the creation of an alert if the base unit is defined as Percentage, it is
displayed as KB when updating the alert.

Workaround: Click on the Condition Tab and enter the value enter the
required value, click Save. The updated values is automatically saved as
Percentage even if the base unit is displayed as KB.

5. Todisable an existing alert:

a. Click Inventory >Platform > Select "Db Node" > File system > /
ericsson/esm_ddc_data .

b. Click Alerts Tab > Definitions.

c. Select all the alert definitions with the description File System
Used Percentage and click Disable.

11.5 Delete Alert Definition Template of a Given Resource
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Steps

1. Loginto ESM GUI, and select Administration.

2. Under the Configuration tab, select Server Plugins.

3. Select the Alert Plugin configuration, then select Disable.
Note: Do not click on the hyperlink.

4. Select Inventory > Platform.

5. Select the required <Platform>> <resource>> select Alerts.

6. Select the required alert definition template, then click Delete.

Note: Do not click on the hyperlink.

1151 Enable Alert Configuration Plugin

1. Logonto ESMON and backup the JAR file.

cp /opt/rhg/rhg-server/modules/org/rhq/server-startup/main/deployments/rhg.e -
ar/rhq-serverplugins/alert-configurer-plugin-1.29.1.jar /tmp/

2. Logonto ESM GUI and navigate to Administration > Server Plugins > Delete
alert configuration plugin and then wait for 10 to 15 minutes to get it flushed
from server.

3. Run the following command in ESMON:

cp /tmp/alert-configurer-plugin-1.29.1.jar /opt/rhq/rhg-serve -
r/plugins/

4. 1In ESM GUI, navigate to Administration > Server Plugins, select Scan for
Updates, and check if the plugin jar is available.

Note: If any alert definition template in Administration > Alert Definition
Templates is edited, the deleted alarm is re-generated.
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12 View Default ESM Alert Thresholds

This section describes how to check the default thresholds for file system and
Linux templates. The templates are visible to all the users of ESM and no specific
permissions are required to view them.

By default, the conditional alerts. That is, File System - Used Percentage, Linux -
Idle, and File System - Options are enabled and Clear alert is disabled. Once the
conditional alert is triggered, then the Clear alert is enabled.

—— RELATED INFORMATION —
12.1 View File System Alert Thresholds on page 65
12.2 View Linux Alert Thresholds on page 68
12.3 View Snapshots Status Alert Thresholds on page 70
12.4 View VM Group Availability Alert Thresholds on page 72

12.5 Edit Conditions on page 74

12.1 View File System Alert Thresholds
1. Click Inventory.
2. Click Platforms.
3. Select any Platform from the Platforms list.

4. Click the File System tab on the left side panel and select one of the available
file systems.
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Dashboard Inventory v  Reports v Bundles Administration v Help
« B cloud-ms-1 - o )
& Bundle Handier - Ant > 403/ eV/SNIM ( e system) @

£ Bundie Handler - File Template | Tags: @

pRHE

Sum mary nventory Alerts \1cr~itorirg
~ B File Systems
Y, Activity Timeline
—
{3 lboot

/dev/shm -0/ [ Resource: Measurements %[2/[7| (x| |=//2 # Resource: Alerts E]E

{6} fericsson/co nfiguration_ma

£} fericsson/custom __ FreeSpace 7 Matching Rows: 0 (selected: 0)

{6} fericsson/enm/alex . Used Percentage

o N - Creation Time = N Cq Conc Priority Ack Recovered
i .’GH[)SO"I’EFN#IJUHWE B See more...

A ori e v No results found using specified criteria
{3 Jericsson/tor/data

£} /etc/opt/ericsson/ERICmodk

&3 /nome O iti

= Acknowledge Delete New Definition
{5} lopt/ericsson/storage/user/ y o b

{6} lopu/ericsson/storage/user)

{6} /s0ftware

-0 [l Resource: 00B Metrics  [%|[e][?] %

Note: RHQ supports up to NFS V2.
Click Alerts.
File System Templates are found on all the File Systems.

File System Options - The alert is triggered when the permissions of any file
system changes such as read or write.

File System Used Percentage - The alert is triggered when the Used
Percentage crosses a certain threshold limit.

Summary nventory Alerts Monitoring
Definitions History
—

Total Rows: 6 (selected: 0)

Name Description Creation Time | Modifled Time | Enabled | Priority = Parent Protected
File System - Used File Systemn Threshold Jan 11,2017 Jan 11,2017 - View Temnlate No
ntage - Clear  exceeded 2:03:26 AM 2:03:26 AM view Tempiate
File Sy se A l l
, |File System - Used File System Threshold Jan 11, 2017 Jan 11, 2017 View Template No
Percentage exceeded 2:03:26 AM 203268m & [ VAT
- ) File System Mode Jan 11, 2017 Jan 11, 2017 -
File Systerm - Options - : - : View Template No
s P Changed 2:03:26 AM 203am O = P
File System - Used File System Threshold Jan 11, 2017 Jan 11, 2017 . -
N . . : . ew Template No
ntage exceedad 2:03:26 AM 203268 & = b plate
File System - Options - File System Maode Jan 11,2017 Jan 11, 2017 e
- View Template No
Clear Changed 2:03:26 AM 203268m @ s - plate
File System - Used File Systemn Threshold Jan 11, 2017 Jan 11, 2017 o
y . . : . View Template No
Percentage exceeded 2:03:26 AM 203268M O = b plate

Result: The complete list of Alert Definitions for File System is displayed.

Select an Alert Definition based on the alert priority as shown in the Priority
column.
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General Properties Conditions Notifications RECOVEW Dampening
Mame : File System - Options - Clear
Description : File System Mode Changed
Priority : jm LOW
Enabled : No
Protected : No

Result: A page displaying general properties and conditions is displayed.

7. Click Conditions.

v B esmon

‘s Bundlc Handler - Ant » {45/ DOOL (Fite system) @
% Bundie Handler -File Template | Tags: @
o ET summary  inventory | Alerts | Monitoring
=
p— Definitions Mt
I R B
. General Properties | Conditions  Notifications ~ Recovery  Dampening

4 Jericssorvenm/dumps Fire alert when : ANY

vdde_data Total Rows: 1 (selected: 0)

Vesm_ddc_data ||
Condition

Metric Value Range: [Used Percentage] between [0.0 %] and (6.0 %], inclusive

> 22 RHQ Storage Nodes

% Wildfly/jBoss EAP Patch Handler

Refresh

Result: The default conditions for the file system of that particular priority
are displayed.

12.1.1 File System Used Percentage

The following table contains the default thresholds for File System
templates.

Table 18 File System Used Percentage

S.No Name Description Condition Alert Priority Notification
Type
1 File System - File System Used Low FM Alert
Used Threshold percentage
Percentage exceeded >=80% and
<=90%
2 File System - File System Used Medium FM Alert
Used Threshold percentage
Percentage exceeded >90% and
<95%
3 File System - File System Used High FM Alert
Used Threshold percentage
Percentage exceeded
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S.No Name Description Condition Alert Priority Notification
Type
>=95% and
<=100%
4 File System - File System Used Low FM Clear Alert
Used Threshold percentage
Percentage - exceeded >=0% and
Clear <=79%

12.1.2 File System Mode Change
The following table contain details on file system modes.
Table 19  File System Mode
S.No Name Description Condition Alert Priority Notification
Type
1 File System - File System When the File Low FM Alert
Options Mode Changed | System
Permissions are
changed from
ReadWrite to
ReadOnly
2 File System - File System When the File Low FM Clear Alert
Options - Clear | Mode Changed | System
Permissions are
changed from
ReadOnly to
ReadWrite
12.2 View Linux Alert Thresholds
1. Click Inventory.
2. Click Platforms.
3. Select any Linux Platform from the Platforms list.
4. Click Alerts.
68 1/1553-CNA 403 3115 Uen AM
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summary Inventory Alerts Monitoring Events
Definitions History

Total Rows: 4 (selected: 0)

Name Description Creation Time = Modified Time
(Rrelils CPU busy threshold Jan 11, 2017 Jan 11,2017
exceeded 2:03:21 AM 2:03:21 AM
. " CPU busy threshold Jan 12, 2017 Jan 12,2017
Linux-Idie -Clear — ceeded 216:17 PM 2:16:17 PM
Linu - Idle CPU busy threshold Jan 12, 2017 Jan12 2017
a exceeded 2:16:17 PM 2:18:17 PM
(Rrells CPU busy threshold Jan 12, 2017 Jan 12,2017
. exceeded 2:16:17 PM 2:16:17 PM

Operations

Drift

Enabled | Priority | Parent

=
%) -
@ -
@ -

View Template

View Template

View Template

View Template

Result: The list of Alert Definitions for Linux platforms is displayed.

\\

Content

Protected

No

No

No

No

5. Select an Alert Definition based on the alert priority as shown in Priority
column, a page displaying General Properties and Conditions is displayed.

= Back to List

General Properties Conditions Notifications Recaovery

Name : Linux - Idle
Description : CPU busy threshold exceeded
1 Priority : = MEDIUM
Enabled : Yes
Protectad : No

6. Click Conditions.

« BdUK LU LIsL

General Properties Conditions Notifications Recovery
Fire alert when : ANY

Total Rows: 1 (selected: 0)

Condition

Metric Value Range: [Idle] between [5.0 %] and [10.0 %], exclusive
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Result: The default thresholds for Linux of that particular priority are
displayed.

12.2.1 Linux Default Alert Thresholds

The following table contains details of Linux default alert thresholds.

Table 20 Linux Default Alert Thresholds

S.No Name Description Condition Alert Priority Notification
Type

1 Linux - Idle CPU busy Idle >=10% and | Low FM Alert
threshold <=15%
exceeded

2 Linux - Idle CPU busy Idle >5% and Medium FM Alert
threshold <10%
exceeded

3 Linux - Idle CPU busy Idle >=0% and | High FM Alert
threshold <=5%
exceeded

4 Linux - Idle - CPU busy Idle >15% to Low FM Clear Alert

Clear threshold <=100%

exceeded

12.3 View Snapshots Status Alert Thresholds

Steps

1. Click Inventory.

2. Click Platform.

3. Select MS platform from the platforms list.
4. Click Snapshots Status.

Dashboard Inventory -~  Reports ~  Bundles  Administraion v  Help

v B ieatimsagss

e U T > EB3SNapshots Status (snapshets status) i
48 Bundle Handler - File Template Tags: &
> 22 cpu
° summary  Inventory  Alers  Monitoring
> 22 File Systems
Activity  Timeline

> 12 Network Adapters
> E3RHQ Agent

+ Snapshots Status |2 Resource: Measurements 2][¢][2][%] [=][B] ® Resource: Alerts £3|E3kd|ES

> & vm Availabilities

> 12 Vvm Group Availabilities A\_ Snapshots Availability o Matching Rows: 4 (selected: 0)

) Wildfiy/JBoss EAP Patch Handler I
Creation Time ~ Name  Condition Condition Value | Priority Acknowledge Recovered ..

m

Snapsh s

~|[5/6@ Resource: 00B Metrics 2|[@[2][X

No 0OB conditions found

m
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Click Alerts.

Inventory v dles

Administration v Help

v B ieatims4935
» EBSNapshots Status (snapshets status)

Tags: @

¢ Bundle Handler - Ant
48 Bundle Handler - File Template

> &2 crus
Summary  Inventory  Alerts  Monitoring
> 1 File Systems

> 22 Newwork Adapters History
> B3 RHQ Agent
> 12 vm Availabilities
> 12 Vm Group Availabiliies
@ Widfy)Boss EAP Patch Handier | 1©

Definitions

Description

napshots Status - Upgrade snapshots availability [with
opl
napshots Status - Upgrade snapshots availability [with
lability - Clear oPI

View Default ESM Alert Thresholds

\\

[CR%s
Total Rows: 2 {selected: 0)
Creation Time Modified Time | Enabled | Priority  Parent Protected
Oct 26, 2017 6:49:26 AM Nov1,2017 24047PM & - N/A
0ct 26, 2017 6:49:26 AM Nov1,20172:40:47PM @ [ N/A

The list Alert Definitions for Snapshots Status is displayed.

Select an Alert Definition based on the alert priority as shown in Priority
column, a page displaying General Properties and Conditions are displayed.

~ B ieatims4935
) Bundie Handler - Ant

> EB3SNapshots Status (snapshoes seatus)

{8 Bundle Handler - File Template Tags: @
L Summary  Inventory | Alerts  Monitoring
> 2 File Systems.
> &% Network Adapters Definitions History
> B3 RHQ Agent
> 12 vm Availabilities
> 21 Vm Group Availabiliies General Properties  Conditions  Notifications  Recovery
{8} Wildfly/JBoss EAP Patch Handler Name . [€81Ms4933 - Snapshots Status - Snapshots
Availability
Description : Upgrade snapshats availability [with OPI]
Priority - HIGH
Enabled : Yes
Click Conditions.
v B ieatimsag35
@ Bundie Handier-Ant > E3SNapshots Status (snapshots status)
&) Bundle Handler - File Template Tags: ©
(i Summary  Inventory | Aleris  Monitoring
> 2 File Systems
> 22 Network Adapters Definidons  History
> E3 RHQ Agent
> 2 vm Availabilities
General Properties  Conditions  Notifications  Recovery

> & Vm Group Availabilities

¢ Wildfly/JBoss EAP Patch Handler | Fire alertwhen : ANY

Condition

Metric Value Threshold [Snapshots Availability > 0.0]

(R4

Dampening

[Ca%4

Dampening

Total Rows: 1 (selected: 0)

The default thresholds for Snapshots Status for the specified priority are

displayed.

2020-11-02
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Snapshot Status Alert Threshold

This table provides details of snapshot status alert thresholds.

Table 21  Snapshots Status Alert Thresholds

S.No Name Description Condition Alert Priority Notification Type
1 Snapshots SAN snapshots snapshots High FM ALERT
Availability older than 3 days availability > @
available.
2 Snapshots SAN snapshots snapshots Low FM Clear ALERT
Availability older than 3 days availability = @
available.

12.4 View VM Group Availability Alert Thresholds

Steps

1. Click Inventory.

2. Click Platform

3. Select MS platform from the platforms list.
4

Click Vm Group Availabilities.

Vm Group Availabilities
Tags:

Sapserv

LD U s vty L eompaie 1

S orsisery nventory Alerts Monitoring

s
£ cmevents
S cmserv
£ dehistory
goms -
S see more
£ malarmprocessing
S mnistory . o Group METIE
q 2 P value
mserv ,
37 "® Threshold
fmx

| /=@ Group: Metrics #&][2][x] [-/[=]® Group: Alerts E| =R~

m

Group Availability 100%

Matching Rows: 2 (selected: 0)

Creation Time » Name  Condition Condition Value Priority Acknowledge Recovered | Resource

)

0

~|[0/@ G E 1& #[[el[z]x
/[ @ Group: 0OB Conditions FRIEX | e (et =

Matching Rows: 0 (selecied: 0)

. | Timestamp ~ Severity | Detalls Source Location Resour .

N results found usir

Bimedcore

Smsap

5. Clickany VM.
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e
5 Vm AvallaDITes

> B3 vm Availability
v 8 Vm Group Availabilities

3 bnsisery
Bads

3 cevents
B cmserv

3 dehistory
Sdims

B3 fisserv

3 fmalarmprocessing
3 fmhistory
5 fmserv
2mx

3 hitpdl

3 impexpserv
3 ipsmsery
B itservices
3 kpiserv

3 srouter
3 medcore

B msap

Definitions.

>Ba PSErV (vm Group Avaliaviiity )

Tags: @
Summary  Inventory  Alerts Monitoring
Definitions History
Description

Group Availability of Vm [with OPI]

Group Availability of Vm [with OPI]

Total Rows: 2 (selected: 0)

Creation Time Modified Time | Enabled  Priority | Parent Protected
Nov 13, 2017 11:48:49 AM Nov13,2017320:14PM & m o view No
Nov 13,2017 11:48:49 AM Nov13,2017320:14PM @ m  View Template No

Result: The list Alert Definitions for VM Group Availability are displayed.

7. Select an Alert Definition based on the alert priority as shown in Priority
column, a page displaying General Properties and Conditions are displayed.

r/ericsson/ddc_data

/i) liovirt

& Narfvown
> &8 Network Adapters
> B3 RHQ Agent
B3 Snapshots S

~ 5 vm Availabilities

> B vm Availability
~ 8 Vm Group Availabilities

3 bnsiserv
Bas

3 cmevents
& amsery
3 dehistory

ricsson/storage/user;

ricsson/storage/user;

Tags: &

summary  Inventory  Aler's  Monitoring

Definitions

History

« Back to List

General Properties  Conditions  Notifications  Recovery

Name : Vim Group Availability - Vm Group Availability
Description : Group Availability of Vim [with OPI]
I HIGH

Vs

No

Priority
Enabled
protected

8. Click Conditions.

Summary

N,

> 12 Network Adapters
> E3RHQ Agent
3 Snapshots Status
~ 5 vm Availabilities
> B vm Availability

8 Vm Group Availabilities

£ bnsiserv
B
3 cmevents

& cmserv

Inventory  Alerts  Monitoring

History

«Back to List

General Properties  Conditions | Notifications  Recovery

Fire alertwinen : ANY

Condition

Metric Value Threshald [Vm Group Availability < 1.0 %]

Dampening

Dampening

Result: The default thresholds for VM Group Availability of a particular
priority are displayed.
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12.4.1 VM Group Availability Alert Thresholds
The following table contains details of VM group availability alert
thresholds.
Table 22 VM Group Availability Alert Thresholds
S.No Name Description | Condition | Alert Notificatio
Priority n Type
1 VM Group | Group VM Group | High FM ALERT
Availability | availability | Availability
of a VM <1.0%
type is less
than 1%
2 VM Group | Group VM Group | Low FM Clear
Availability | availability | Availability ALERT
ofaVM >1.0%
type is
greater
than 1%
12.5 Edit Conditions

The user can edit the conditions at individual alert definition level, which is
applicable for only file system or Linux platform and globally for all the file
systems and Linux platform templates at administration.

1. Click Administration.

2. Click Alert Definition Templates under the Configuration section on the side

menu.

3. Click Edit for either File System or Linux.

74
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~ Platforms

Name = Enabled Templates Disabled Templates Edit?
EHP-UX 0 0 /7
Elava 0 0 rd
ELinux 3 1 Ve
EMac 05X 0 0 rd
= platform-a 0 0 4

~ Platform Services

Name = Enabled Templates Disabled Templates Edit?
83 CPU 0 0 rd

{85 Directory

& File System

{85 File Template Bundle Handler

(=R = B N =]
(=R = R N 0 =]
NNINN

£8% Hosts File

~ Servers

4. Select atemplate, and a page displaying general properties and conditions
are displayed.

5. Edit the required conditions.
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View Alerts for EMC Clariion or VNX Storage

ENM System Monitor (ESM) raises alarms when EMC-Clariion or VNX
hardware fails. These templates are visible to all the users of ESM and no
specific permissions are required to view them.

Prerequisites

— The user is logged on to Ericsson System Monitor.

— EMC Storage is imported.

Steps

1. Click Inventory.
Click Platforms.
Click esmon.

2

3

4. Click EMC Storages.
5. Click any Hardware under EMC Storages.
6

Click Alerts.

Dashboard Inventory v  Reports v  Bundles Administration ~  Help
v Security «Back to List

4 Users

S Alert Definition Templates [EMC Storage]
v Topology

B3 Servers Total Rows: 14 (selectzd: 0]

@ o s
& Storage Nodes Description Creation Time Modified Time  Enabled | Priority.

¥

ENC Hardware has been faulted [with OPI] May 20,2017 7:37:02PM
oups 1 37.02PM

&) Partition Events

~ Configuration

# System Settings

Alert Definition Templates "

b Drift Definition Templates

/ Metric Collection Templates

L 1znored Resaurce Ty,
L3 Missing Resource Policy
[] Downloads

% Agent Plugins

% Server Plugins

OROAROOOROOQRRQS

TYFYTF T T T TTFTTTNE

v Content

8 Content Sources

—— RELATED INFORMATION —

13.1 Default Threshold for ENM Storage on page 77
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13.2 ESM EMC Metrics on page 78

View Alerts for EMC Clariion or VNX Storage

\\

13.1

Default Threshold for ENM Storage

The following table contains details of the default thresholds for EMC

Storage.

Table 23  Default Threshold for ENM Storage

S.No Name Description Condition Alert Priority Notification
Type
1 EMC Storage - EMC Hardware | Fault Count>0 | CRITICAL FM Alert
Fault Count is faulty
2 EMC Storage - EMC Hardware | Fault Count=0 | LOW FM Clear Alert
Fault Count - has been
Clear recovered
3 EMC Storage - EMC SPA Read | Not Enabled CRITICAL FM Alert
SPA Read Cache state is
Cache State not enabled
4 EMC Storage- | EMCSPA Read | Enabled LOW FM Clear Alert
SPA Read Cache state is
Cache State - enabled
Clear
5 EMC Storage - EMC SPA Write | Not Enabled CRITICAL FM Alert
SPA Write Cache state is
Cache State not enabled
6 EMC Storage - EMC SPA Write | Enabled LOW FM Clear Alert
SPA Write Cache state is
Cache State - enabled
Clear
7 EMC Storage - EMC SPB Read | Not Enabled CRITICAL FM Alert
SPB Read Cache state is
Cache State not enabled
8 EMC Storage - EMCSPB Read | Enabled LOW FM Clear Alert
SPB Read Cache state is
Cache State - enabled
Clear
9 EMC Storage - EMC SPB Write | Not Enabled CRITICAL FM Alert
SPB Write Cache state is
Cache State not enabled
10 EMC Storage - EMC SPB Write | Enabled LOW FM Clear Alert
SPB Write Cache state is
Cache State - enabled
Clear
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13.2

78

ENM System Monitor User Guide

ESM EMC Metrics

This table contains details of the EMC Storage Metrics.

Table 24 EMC Storage Metrics

S.No Metric Name Description Collection Interval
1 Fault Count Count of faulted 15 minutes
hardware
components
2 SPA Read Cache | Displays SPA 1 hour
State Read Cache state
as @ (disabled) or
1 (enabled).
3 SPA Write Cache | Displays SPA 1 hour
State Write Cache state
as @ (disabled) or
1 (enabled).
4 SPB Read Cache | Displays SPB 1 hour
State Read Cache state
as @ (disabled) or
1 (enabled).
5 SPB Write Cache | Displays SPB 1 hour
State Write Cache state
as @ (disabled) or
1 (enabled).
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